
Siebel Public Sector 
Guide
Version 7.8
February 2005



 

Siebel Systems, Inc., 2207 Bridgepointe Parkway, San Mateo, CA 94404
Copyright © 2005 Siebel Systems, Inc. 
All rights reserved.
Printed in the United States of America

No part of this publication may be stored in a retrieval system, transmitted, or reproduced in any way, 
including but not limited to photocopy, photographic, magnetic, or other record, without the prior 
agreement and written permission of Siebel Systems, Inc.

Siebel, the Siebel logo, UAN, Universal Application Network, Siebel CRM OnDemand, TrickleSync, 
Universal Agent, and other Siebel names referenced herein are trademarks of Siebel Systems, Inc., and 
may be registered in certain jurisdictions.

Other product names, designations, logos, and symbols may be trademarks or registered trademarks of 
their respective owners. 

PRODUCT MODULES AND OPTIONS. This guide contains descriptions of modules that are optional and 
for which you may not have purchased a license. Siebel’s Sample Database also includes data related to 
these optional modules. As a result, your software implementation may differ from descriptions in this 
guide. To find out more about the modules your organization has purchased, see your corporate 
purchasing agent or your Siebel sales representative.

U.S. GOVERNMENT RESTRICTED RIGHTS. Programs, Ancillary Programs and Documentation, delivered 
subject to the Department of Defense Federal Acquisition Regulation Supplement, are “commercial 
computer software” as set forth in DFARS 227.7202, Commercial Computer Software and Commercial 
Computer Software Documentation, and as such, any use, duplication and disclosure of the Programs, 
Ancillary Programs and Documentation shall be subject to the restrictions contained in the applicable 
Siebel license agreement. All other use, duplication and disclosure of the Programs, Ancillary Programs 
and Documentation by the U.S. Government shall be subject to the applicable Siebel license agreement 
and the restrictions contained in subsection (c) of FAR 52.227-19, Commercial Computer Software - 
Restricted Rights (June 1987), or FAR 52.227-14, Rights in Data—General, including Alternate III (June 
1987), as applicable. Contractor/licensor is Siebel Systems, Inc., 2207 Bridgepointe Parkway, San 
Mateo, CA 94404.

Proprietary Information

Siebel Systems, Inc. considers information included in this 
documentation and in Siebel Business Applications Online Help to be 
Confidential Information. Your access to and use of this Confidential 
Information are subject to the terms and conditions of: (1) the 
applicable Siebel Systems software license agreement, which has 
been executed and with which you agree to comply; and (2) the 
proprietary and restricted rights notices included in this 
documentation.



Contents
Siebel Public Sector Guide 1

Chapter 1:  What’s New in This Release

Chapter 2:  Overview of Siebel Public Sector
Key Features of Siebel Public Sector 10

About Case Management 10

Reports and Analytics for Siebel Public Sector 13

Accessibility and Public Sector 13

Customer Portal for Siebel Public Sector 14

Chapter 3:  Getting Started with Siebel Public Sector
Administrator Setup Tasks for Siebel Public Sector 18

Adding an Image to the Home Page Warning Level Indicator 21

Activating Public Sector Workflows 21

Assignment Manager and Siebel Public Sector 22

Chapter 4:  Setting Up and Using Adobe Forms Integration
About Forms Integration 24

Business Scenarios for Form Integration 25

Process of Setting Up Adobe Forms Integration 25

Preparing for Adobe Form Integration Setup 27

Creating the Web Service for Adobe Forms Integration 28

Configuring the Web Service for Adobe Forms Integration 29

Enabling Forms Integration for Additional Applets Using Siebel Tools 29

Creating an Integration Object for Adobe Forms Integration 30

Generating an XML Schema for Forms Integration 31

Mapping the XML Schema to the PDF Form Using Adobe Designer 31

Creating the Form Record Referencing the PDF File 32

Generating a Form Using a Siebel Record (End User) 34
Siebel Public Sector Guide Version 7.8 3



Contents ■ 
Chapter 5:  Managing Benefits Cases
Scenarios for Benefits Case Management 38

Process of Managing Benefits Cases 39

Receiving a Benefits Request 40

Creating a Case File During the Intake Process 41

Calculating Benefits Eligibility 42
Using Siebel SmartScript to Gather Benefits Assessment Information 42
Using eAdvisor to Manage a Benefits Eligibility Assessment 43
Assessment of Benefits Using Templates and Activities 43

Reviewing Benefits Case Details 44

Referring Cases to Third-Party Providers 45

Chapter 6:  Managing Investigative Cases
Scenarios for Investigative Case Management 48

Process of Managing Investigative Cases 49

Creating an Incident Report 50
Adding Details to an Incident 51
Escalating an Incident to a Case for Investigation 52

Developing a Case for an Investigation 52
Adding Case Details and Scheduling Follow-Up Activities 54

Creating Suspect Profiles for an Investigation 55
Adding Suspect Details and Scheduling Follow-Up Activities 56

Creating Group Profiles for an Investigation 57
Adding Details to a Group Profile 58

Creating Accounts and Contacts for Sharing Case Information 58

Chapter 7:  Managing Health Threats and Response
Scenario for Health Threat and Response Management 62

Process of Managing Public Health Cases 63

Creating a Disease Record 63

Developing Disease Details 64

Managing Disease Response Inventory 65

Managing Calls on Suspected Health Threats 67

Searching for Information on Health Topics 67
Siebel Public Sector Guide Version 7.84 



Contents ■
Creating and Modifying Health Topic Content 68

Contributing to and Approving Content for Health Topics 68

Chapter 8:  Managing Tax Cases
Scenarios for Tax Case Management 72

Process of Managing Tax Cases 73

Working with Tax Case Files 73
Creating Multiple Case Records 74
Adding Case Attachments and Notes 74
Managing the Case Calendar and Activities 75
Tax Case Assessment Tasks 76
Routing and Assignment of a Tax Case 76
Associating a Contact or a Partner with a Case 77
Case Correspondence Management 77
Tracking Case Status 78
Closing and Reopening a Case 78

Chapter 9:  Managing Immigration Contacts
About the Immigration Contacts Screen 80

Scenario for Managing Immigration Contacts and Identities 81

Process of Managing Immigration Contacts 82

Adding a Contact Identity Record 82

Adding Immigration Contact Details 84

Documenting Immigration Contact Credentials 85

Documenting Identity History 86

Merging Immigration Contacts 87

Managing Visitor Stays 87

Administering Immigration Contacts 89

Appendix A: Public Sector Responsibilities and Views
Public Sector Responsibilities 92

Investigative Case Management Responsibility 92

Incident Management Responsibility 94

Threat and Response Management Responsibility 94

Benefits Case Management Responsibility 95
Siebel Public Sector Guide Version 7.8 5



Contents ■ 
Index
Siebel Public Sector Guide Version 7.86 



1 What’s New in This Release
What’s New in Siebel Public Sector Guide, Version 7.8
Table 1 lists content described in this version of documentation to support release 7.8 of the 
software.

Table 1. New Product Features in Siebel Public Sector Guide, Version 7.8

Topic Description

Adobe Forms Integration

See Chapter 4, “Setting Up and 
Using Adobe Forms Integration.”

This new feature allows Adobe PDF forms, such as 
applications, to be mapped to, and then automatically 
populated with Siebel data.

Immigration Contacts screen

See Chapter 9, “Managing 
Immigration Contacts.”

This new feature provides an Immigration Contacts home 
screen customized for use by citizenship and immigration 
agencies.
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2 Overview of Siebel Public Sector 
Siebel Public Sector is an integrated suite of Web-based applications designed for use by 
administrators and end users associated with municipal governments, social services, tax 
management, public health, immigration and investigative agencies. This chapter provides an 
overview of the applications that make up Siebel Public Sector. It includes the following topics:

■ Key Features of Siebel Public Sector on page 10

■ About Case Management on page 10

■ Reports and Analytics for Siebel Public Sector on page 13

■ Accessibility and Public Sector on page 13

■ Customer Portal for Siebel Public Sector on page 14
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Key Features of Siebel Public Sector
Siebel Public Sector provides an integrated foundation for complex case, service, and agency 
management, and addresses the initiative towards performance-driven government. Using Siebel 
Public Sector, government and municipal agencies can manage:

■ Case information from initial referral through case investigation, and benefits delivery. 

■ Self-service processes for information, eligibility assessment, single-application filing for multiple 
programs, and claims management.

■ Communications for agency-to-citizen, agency-to-agency, and agency-to-third party providers.

■ Assignment of high volumes of cases to employees with the right skills and availability.

■ Data integration from multiple channels and back-office applications, giving case workers a 
comprehensive view of the citizen.

■ Automatic population of PDF forms, such as immigration and visa applications, with Siebel data.

■ Team collaboration and information sharing among employees, agencies and partner 
organizations working on a case.

■ Case management analysis reports.

■ Immigration and visitor stay management

About Case Management
The process of case management varies depending on the government agency using Siebel Public 
Sector. To a human services agency, a case often represents a request for benefits. A law 
enforcement department or national security agency typically uses the term case to refer to an 
investigation. A tax agency case can be an audit, an attempt to collect taxes due, or a taxpayer 
inquiry about a tax bill. Siebel Public Sector's case management functionality has been designed to 
meet the needs of a broad range of case management uses.

While each type of case has its own specific requirements, and individual agencies have their own 
unique procedures for managing cases, many of the underlying case management processes are very 
similar. Cases are created within the system, and assigned to an owner. Supporting documentation 
and other details need to be added to the case. The case owner, and possibly other employees, must 
complete a set of activities to process the case.
Siebel Public Sector Guide Version 7.810 
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Cases Home Page
The Cases Home page is a useful starting point that provides access to a number of case 
management tools. The Cases Home page allows users to locate existing case records using the 
Search applet; to quickly create a new case record when needed, and to navigate to recently viewed 
records. In addition, the Cases home page shows all case management iHelp tasks to which the user 
has permissions. The central section of the home page incorporates a set of links that users can 
employ to navigate to frequently used sets of case data, by combining a specific case view with a 
predefined query. These links are maintained by an analyst or administrator using the Administration 
- Application screen's View Links view. End users can create personal view links using the User 
Preferences screen's View Links view. For more information, see Applications Administration Guide 
and Fundamentals.

Case Records Management
New case records can be created from the Cases Home page or from the Case List view. Cases can 
be created on behalf of an individual, a household, or a group of individuals. For example, an 
employment agency might open a case when a person who has lost his or her job files for 
unemployment benefits; a tax agency might start an audit of a married couple whose tax returns 
seem to be inaccurate, and an investigator might open a case to scrutinize a motorcycle gang 
suspected of several crimes. Actions and interactions can be captured by the case management 
module.

Cases also can be created for a particular Contact record using the Contacts screen's Cases view. 
The information from the Contact record might be used to populate beneficiary information for the 
case. Similarly, a case can be created for a particular household record using the Households screen's 
Cases view.

If new case records share many of the same attributes, users can also reduce the time required for 
data entry by using Quick Fill templates. Quick Fill templates capture the common values, such as 
those for a certain Case Type, and can be applied to other case records. Quick Fill templates are 
accessible from the case form menu on the Case List view. For more information on using Quick Fill 
templates, see Fundamentals.

Assignment of Cases and Ownership
By default, cases are assigned to the user who creates the case. Cases can be assigned to one or 
more employees. Assignment of cases can occur automatically, based on geographic location, 
availability, or other criteria, using Siebel Assignment Manager. An Assignment Object for Case 
(displayed as PUB Case in the list of objects on the Administration - Assignment view) is 
preconfigured in the Public Sector application. Administrators can set up assignment rules based on 
various criteria of the case record. Case ownership can also be adjusted manually by adding 
employees to the case team. For more information on administering case assignment, see 
“Assignment Manager and Siebel Public Sector” on page 22 and Siebel Assignment Manager 
Administration Guide. 

A case team member can see cases to which he belongs on the My Cases view. For managers, the 
My Team's Cases view provides a means to review cases owned by primaries whose assigned position 
is subordinate to the manager's position. Some supervisors and administrators may need access to 
the All Cases view, which lists all cases, regardless of ownership.
Siebel Public Sector Guide Version 7.8 11
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Development of Case Tasks Using iHelp
Organizations may want to define case management business processes using iHelp, which provides 
tasks instructions using a step format, and includes embedded view navigation links. In addition, 
iHelp can highlight important fields and buttons on the view associated with each step of the task to 
draw the user's attention to the controls that should be used to complete the task. These tasks are 
available from the Cases Home page, and from anywhere in the Case Screen by clicking on the iHelp 
icon in the task bar. For more information on using iHelp, see Fundamentals.

Addition of Case Details and Supporting Documentation
Members of the case team can add supporting documentation and information to a case record using 
a number of different views associated with the Cases screen. For more information, see “Adding Case 
Details and Scheduling Follow-Up Activities” on page 54. 

Case Activity Plans
Agencies can incorporate standard case management practices into activity plans associated with 
cases to make sure that all cases are handled in a consistent manner. An activity plan is a set of tasks 
(activities in the Siebel data model) that must be completed to finish processing the case. An 
administrator or analyst can create the activity plans using the Administration - Data screen's 
Activity Templates view. Within the template, each discrete activity can be assigned a description, 
priority, duration, and other details. When creating case activity plans, the Type value is set to Case 
so that the activity plan is available from the Cases screen. Developers can use Siebel workflow to 
automate the process of adding Activity Plans to a case record. For more information, see 
Applications Administration Guide and Siebel Business Process Designer Administration Guide.

Case Relationships
Case records can be related to other case records. The ability to associate one case to another may 
be useful for tracking purposes if a person has previously applied for benefits, or if two or more 
investigations are found to have common aspects. When a case record is added as a related case to 
another case, the latter case is also added as a related case to the former. For example, if Case A is 
added to the list of related cases for Case B, then Case B is automatically included in the list of cases 
related to Case A.

Case Audits
Each case record includes an audit trail, which stores changes made to fields in the case record. 
Administrators can specify and adjust which fields are audited using the Administration screen’s 
Audit Trail view. Administrators or supervisors can be granted access to the case audit trail to see 
which users have made changes to a case record. In some instances, it may make sense to make 
the audit trail visible to a broader group of people who need insight into a case's history. For more 
information on audit trail, see Applications Administration Guide.
Siebel Public Sector Guide Version 7.812 
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Reports and Analytics for Siebel Public 
Sector
You can generate a number of preconfigured reports from various screens in the Siebel Public Sector 
application. Table 2 describes the reports and screens. For more information on generating 
preconfigured reports, see Fundamentals.

In addition to the preconfigured reports, a Siebel Analytics module specific to Siebel Public Sector 
can be purchased to provide enhanced analyses for various business processes. For more information 
about Analytics reports, see Siebel Analytics User Guide.

Accessibility and Public Sector
Siebel Public Sector software includes accessibility features that allow use of assistive technology 
hardware and software with Siebel Business applications. For more information about accessibility 
features, see Accessibility Guide for Siebel Business Applications.

Table 2. Public Sector Preconfigured Reports

Report Description

Investigative Case 
Overview Report

 A case investigation report that includes details about all suspects 
and groups associated with the case, related cases, activities 
performed, and public notes created as part of the investigation. 
From the Cases screen, click the Reports button on the toolbar.

Case Overview Report This report provides a synopsis of a benefits or a tax case, including 
the case details, activities, and public notes associated with the case. 
From the Cases screen, click the Reports button on the toolbar.

Incident List Report This report includes a list of incidents. From the Incidents screen, 
click the Reports button on the toolbar.

Suspect List Report This report includes a list of all suspects and details about each 
suspect. From the Suspects screen, click the Reports button on the 
toolbar.

Group List Report This report includes a complete list of groups and details about each 
group. From the Groups screen, click the Reports button on the 
toolbar.

Disease Overview Report This report includes details for each disease record, as well as a list 
of all cases associated with the disease, medications available for 
response, training courses and frequently asked questions about the 
disease. From the Diseases screen, click the Reports button on the 
toolbar.
Siebel Public Sector Guide Version 7.8 13
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Customer Portal for Siebel Public Sector
Customers logging into a Public Sector Web site find a portal that offers self-service, assisted service, 
FAQs and other resolution documents.

Figure 1 shows an example of a customer portal for Public Sector.

Search
Perform a full-text search for information throughout the Web site. Search results are ranked by 
relevancy and personalized visibility. For more information, see Fundamentals and Siebel Search 
Administration Guide.

Ask a Question (Smart Answer)
Perform natural language searches to retrieve knowledge base data. For more information, see 
Fundamentals, Siebel Search Administration Guide and Siebel Smart Answer Administration Guide.

Top FAQs
Access the most requested Frequently Asked Questions and solutions.

Figure 1. Sample Public Sector Customer Portal
Siebel Public Sector Guide Version 7.814 
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My Account (Service Request Management)
Submit and track service requests and determine the status of cases. The customer can attach 
documents to help communicate a service issue. A service agent can add solutions or documents 
relating to the problem. Workflow process can be activated to notify a customer by email whenever 
an agent updates a service request. 

For more information about workflows see “Activating Public Sector Workflows” on page 21 and Siebel 
Business Process Designer Administration Guide. For more information about service requests and 
service email alerts, see Siebel Field Service Guide.

Self-Service
Browse the integrated, searchable knowledge base that consists of knowledge items such as 
solutions to problems, relevant news, resolution documents, downloads, literature, and general 
documents. Knowledge retrieval methods include full-text search, natural language search, database 
query, or navigation through the hierarchical knowledge categories.

You can also:

■ Troubleshoot problems, using a variety of support and service tools to provide solutions.

■ View instructions and other documentation.

■ Access software updates, if applicable.

Contact Us
Contact Customer Care representatives using email, postal mail, and fax, and locate a nearby 
government office.
Siebel Public Sector Guide Version 7.8 15
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3 Getting Started with Siebel 
Public Sector
This chapter lists the applications administration tasks that are specific to Siebel Public Sector. It 
includes the following topics:

■ Administrator Setup Tasks for Siebel Public Sector on page 18

■ Adding an Image to the Home Page Warning Level Indicator on page 21

■ Activating Public Sector Workflows on page 21

■ Assignment Manager and Siebel Public Sector on page 22

Use this chapter in combination with Applications Administration Guide which includes information 
on the setup tasks that are common to all Siebel Business Applications such as using license keys, 
defining employees, and defining your agency’s structure. Applications Administration Guide also 
provides the information that you need to perform data administration and other administration 
tasks.

Some tasks discussed in this chapter may replace the corresponding tasks in the Applications 
Administration Guide, whereas others may be additional tasks. Make sure you review Table 3 on 
page 18 before following the procedures in Applications Administration Guide.

This guide assumes that you have already installed Siebel Public Sector. If you have not installed the 
application, review the Server Installation and Upgrade section of Siebel Bookshelf and click the links 
to the guides that are relevant to your agency’s implementation.

For instructions on how to create the Siebel Administrator account that is used to perform the 
administrative procedures described in this guide, see the Siebel Installation Guide for the operating 
system you are using.
Siebel Public Sector Guide Version 7.8 17
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Administrator Setup Tasks for Siebel 
Public Sector
Table 3 lists and describes the administrative setup tasks that are specific to Siebel Public Sector 
applications and the tasks that may differ from those of the other Siebel Business Applications. The 
table also directs you to documentation that provides information about each task.

When setting up your application, use Table 3 in combination with Applications Administration Guide. 

Table 3. Administrative Tasks for Siebel Public Sector

Administrative Task Description For More Information

Activity Plan templates If your organization uses activity plans with 
predefined activities, these templates must 
be set up. When creating a new Activity 
Template to use with Cases, the Type value 
must be set to HLS Case.

Applications 
Administration Guide

Adobe Forms 
Integration

If your organization wants to automatically 
populate PDF forms, such as citizenship and 
immigration applications, with Siebel data, 
an integration object must be selected or 
created, a schema generated, and the XML 
schema mapped to the PDF form.

Chapter 4, “Setting Up and 
Using Adobe Forms 
Integration.”

Assessment templates If your organization mandates specific 
assessment criteria, assessment templates 
with attributes must be set up. When 
creating a new Case Assessment template, 
set the Type value to HLS Case.

Applications 
Administration Guide

Assignment Manager If your organization wants to automate the 
assignment of case- and immigration-
related activities, you can use Assignment 
Manager’s predefined assignment objects.

“Assignment Manager and 
Siebel Public Sector” on 
page 22

Siebel Assignment 
Manager Administration 
Guide

Business Processes 
(Workflow)

If your organization wants to design and 
implement automatic business process 
flows, you can use the Business Process 
Designer. Some predefined workflow 
processes must be activated.

“Activating Public Sector 
Workflows” on page 21.

See also Siebel Business 
Process Designer 
Administration Guide
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Data loading and 
integration

If your organization wants to integrate with 
other database applications or perform 
periodic batch imports and exports of data 
between the Siebel database and other 
applications, you can perform these tasks 
using Siebel EIM.

Using EIM, you can work with the following 
objects and their components:

■ Cases

■ Diseases

■ Groups

■ Medications

■ Suspects

■ Incidents

Siebel Enterprise 
Integration Manager 
Administration Guide

Integration Platform 
Technologies: Siebel 
Enterprise Application 
Integration

Transports and Interfaces: 
Siebel Enterprise 
Application Integration

Business Processes and 
Rules: Siebel Enterprise 
Application Integration

Siebel Object Interfaces 
Reference

Home Page image If your organization wants to maintain a 
graphic displayed to users on the Public 
Sector application home page, you can 
perform this task using the Home Page 
Image Administration screen.

“Adding an Image to the 
Home Page Warning Level 
Indicator” on page 21

iHelp If your organization wants to set up iHelp to 
provide real-time task assistance to users, 
you can use the iHelp tool to embed view 
navigation links and highlight fields and 
buttons on the view that are associated with 
each step of the task.

Applications 
Administration Guide 
(developing and 
administering iHelp)

Fundamentals 
(using iHelp)

Lists of Values (LOVs) If your organization wants to create 
standard LOVs for Case Type and Stage, and 
Case Status and Sub-Status values, you can 
create and modify lists of values.

Applications 
Administration Guide

Table 3. Administrative Tasks for Siebel Public Sector

Administrative Task Description For More Information
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Mobile 
Synchronization

If mobile devices are used by your 
organization’s personnel, the following 
objects and child components should be 
activated on the mobile devices with the 
following visibilities:

■ Cases (My and Team's)

■ Groups (My and Team's)

■ Suspects (My and Team's)

■ Diseases (My and Team's)

■ Medications (All)

Each object should have partial visibility to 
all child components.

Siebel Service Handheld 
Guide

Quickfill templates If your organization wants to create 
standard templates for commonly used 
Incident and Case types, you can create 
Quick Fill templates. 

End users can apply templates from the 
Case and Incident forms by clicking the 
menu button in the form and choosing Apply 
Template, Save as Template, New from 
Template, or New from Last Template.

Applications 
Administration Guide

Responsibilities If your organization wants to restrict the 
visibility of views based on each employee’s 
responsibilities, you can assign 
responsibilities for each user.

For a list of default views associated with 
each responsibility, see Appendix A, “Public 
Sector Responsibilities and Views.”

Security Guide for Siebel 
Business Applications

Applications 
Administration Guide

Siebel Tools If your organization wants to change or 
create new application fields or field 
properties, change colors and controls in the 
application, and add or remove applets, you 
can perform these tasks using Siebel Tools.

Configuring Siebel 
Business Applications

Siebel Developer’s 
Reference

Siebel Tools Online Help

Using Siebel Tools

Training 
Administration

If your organization wants to set up Training 
courses for users, you can perform these 
tasks using Siebel Training.

Siebel Training Guide

Table 3. Administrative Tasks for Siebel Public Sector

Administrative Task Description For More Information
Siebel Public Sector Guide Version 7.820 
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Adding an Image to the Home Page 
Warning Level Indicator
Siebel Administrators can change the image displayed in the Warning Level indicator on the Siebel 
Siebel Public Sector home page using the Home Page Image Administration screen. After the image 
is published, the image is visible to all users within the same organization. Different organizations 
can display different images.

To add an image to the Home Page Warning Level indicator

1 Navigate to the Home Page Image Administration screen.

2 In the Image list, add an image record and complete the fields.

For optimal layout on the home page, the image should be no larger than 350 pixels wide by 175 
pixels high. 

3 Select the Publish check box to display the image on the home page.

NOTE: The administrator can add additional images to the Images list, however the Publish 
check box should only be selected for the single image to be displayed on the home page.

Activating Public Sector Workflows
Activating the Immigration workflows allows tracking of expired credentials such as visas and 
passports, and immigration overdue records. Case workflows allow cases to be created from 
incidents and reopened after being closed. You only need to activate these workflows once for a 
database. For more information on working with workflows, see Siebel Business Process Designer 
Administration Guide.

Complete the steps in the following procedure to activate the Immigration Stays and Case Workflows 
for Siebel Public Sector.

To activate immigration and case workflows

1 Navigate to the Administration - Business Process screen > Workflow Processes view.

2 In the Workflow Processes list, query for *PUB*, and check the status.

3 If the workflow processes are inactive, navigate to Administration - Business Process screen > 
Workflow Deployment view.

4 In the Repository Workflow Deployment list, query for the PUB workflow process and click 
Activate.

The following table lists each Public Sector workflow process and its business object:

Workflow Process Business Object

PUB GOV Case Re-open (Service) HLS Case

PUB HLS Create Case PUB HLS Incident
Siebel Public Sector Guide Version 7.8 21
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Assignment Manager and Siebel Public 
Sector
You can use Siebel Assignment Manager to automate the assignment of case-related activities and 
to assign activities to case managers based on specific skills and availability.

Some of the predefined assignment objects and underlying criteria described in Siebel Assignment 
Manager Administration Guide have been modified to support Siebel Public Sector business 
processes.

Predefined assignment objects that are specific to Siebel Public Sector are:

■ Cases

■ Suspects

■ Groups

■ Incidents

■ Diseases

Siebel Assignment Manager Administration Guide describes how to implement this functionality, and 
define assignment rules for each task.

PUB HLS Display Error PUB HLS Incident

PUB HLS Go To view HLS Case

PUB Immigration Credential Expiry PUB Immigration Stays

PUB Immigration Overdue Days No 
Visa

PUB Immigration Stays

PUB Immigration Overdue Days PUB Immigration Stays

Workflow Process Business Object
Siebel Public Sector Guide Version 7.822 



4 Setting Up and Using Adobe 
Forms Integration
This chapter describes how to set up and use Adobe Forms Integration. It includes the following 
topics:

■ About Forms Integration on page 24

■ Business Scenarios for Form Integration on page 25

■ Process of Setting Up Adobe Forms Integration on page 25

■ Preparing for Adobe Form Integration Setup on page 27

■ Creating the Web Service for Adobe Forms Integration on page 28

■ Configuring the Web Service for Adobe Forms Integration on page 29

■ Enabling Forms Integration for Additional Applets Using Siebel Tools on page 29

■ Creating an Integration Object for Adobe Forms Integration on page 30

■ Generating an XML Schema for Forms Integration on page 31

■ Mapping the XML Schema to the PDF Form Using Adobe Designer on page 31

■ Creating the Form Record Referencing the PDF File on page 32

■ Generating a Form Using a Siebel Record (End User) on page 34
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About Forms Integration
Government agencies generate a number of paper documents for record-keeping purposes when 
processing applications such as those for immigration, citizenship, and visas. These documents may 
include letters to applicants as well as standardized forms with a precise layout that must be 
maintained. Forms and letters may be issued on preprinted paper stock (such as with visas). Data 
that is captured in the Siebel application can be used to populate these forms and letters.

Siebel Public Sector provides preconfigured Web Services-based integration with Adobe Forms 
Server 6.0 and Adobe Forms Designer software. This integration allows generation of PDF forms 
based on data captured in the Siebel application. For example, users can extract contact data pulled 
from the Siebel database within an application such as Siebel Call Center, and populate the 
appropriate fields in a standard PDF application form.

The data for the form can come from a record's primary business component, as well as any child 
business components. The available forms are those that are associated with the primary business 
component. Using a search specification, the application can also select a particular record from a 
child business component (for example, selecting the primary contact associated with the case 
record).

Users can also generate multiple populated PDF forms at one time by selecting the records in the 
Siebel application, (for example, contact records) and then choosing the appropriate form to 
generate for the records. Output is saved in the Siebel application as an attachment, and can then 
be opened using Adobe Acrobat Reader and printed, edited, emailed, or saved to disk.

Using Adobe Designer, administrators map the Siebel data to fields in an Adobe PDF form using drag 
and drop functionality. Administrators can also specify the text style (font), size, justification and 
word wrapping for the entire form, on a field-by-field basis, or choose to use the default style 
settings.

Within the Siebel application, the Forms Administration view provides a list of forms available within 
the application. Each form’s available date and expiration date determines the form’s availability to 
end users, and provides version control.

End users can choose a record in the Siebel application, select Generate Form from the menu, and 
produce the desired populated form.
Siebel Public Sector Guide Version 7.824 



Setting Up and Using Adobe Forms Integration ■ Business Scenarios for Form
Integration
Business Scenarios for Form Integration
The following scenarios provide examples of processes performed by administrators and end users. 
Your organization may follow different processes according to your particular business requirements.

NOTE: Users can generate a schema, and then import and map to fields on a PDF using either XSD 
or XML data. In these business scenarios, XML is used to illustrate the examples.

Setting Up Forms Integration
An immigration and citizenship agency administrator generates an XML schema and maps Siebel XML 
data to fields in a visa application form. The administrator then creates a form record that can be 
selected by agency personnel when processing applications for visitor status.

Generating a Form from Siebel Data
A client requests written proof of his citizenship. A citizenship clerk locates the client’s record, 
determines that the client is a citizen, and generates a proof of citizenship form. The system 
generates the form, completing it with data from the client's contact record. The clerk can then print 
the form and mail it, or electronically transmit the form to the client.

Generating Multiple Forms
A citizenship clerk prepares all the necessary documentation for a citizenship ceremony. Before the 
ceremony, the clerk prints a new grant of citizenship form for each client who is scheduled to attend 
the ceremony. Each form is printed on an official government document, with fields for specific 
information about the client (for example, First Name, Last Name) and general information about the 
event (for example event date, office location, and so on) 

The clerk reviews the list of clients scheduled to attend the event, selects the client records, and then 
chooses the appropriate form that must be generated. The system creates the forms populated with 
the required data. The clerk can then review the forms before sending them to a printer.

Process of Setting Up Adobe Forms 
Integration
This section lists the tasks typically performed by administrators when setting up Adobe forms 
integration. Your organization may follow a different process according to its business requirements.

Figure 2 shows the system processes that occur, from the design process through end user 
generation of forms, when implementing Adobe forms integration with Siebel application data. 

NOTE: Administrators can generate a schema, and then import and map to fields on a PDF using 
either XSD or XML data. In this process, XML is used in the procedures.
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Administrator Procedures
The following list shows the tasks that administrators typically perform to set up Adobe forms 
integration:

1 Install the required Adobe software. For more information, see “Preparing for Adobe Form 
Integration Setup” on page 27.

2 Using Siebel Tools, create the Adobe Web Service. For more information, see “Creating the Web 
Service for Adobe Forms Integration” on page 28.

3 Configure the Adobe Web Service. For more information, see “Configuring the Web Service for 
Adobe Forms Integration” on page 29.

4 (Optional) If forms integration functionality is required for business objects other than those that 
are preconfigured for Public Sector, use Siebel Tools to add Adobe form integration functionality. 
For more information, see “Enabling Forms Integration for Additional Applets Using Siebel Tools” on 
page 29.

5 During the design process, use Siebel Tools to create an integration object for the selected 
business component. For more information, see “Creating an Integration Object for Adobe Forms 
Integration” on page 30. 

6 In Siebel Public Sector, a preconfigured PUB Immigration Contact integration object is provided. 
For core Siebel Business Applications (non-industry specific), a Sample Contact integration 
object is provided. Verify that both objects are active; the Inactive check box flag should be 
deselected.

7 Generate the XML schema document. For more information, see “Generating an XML Schema for 
Forms Integration” on page 31.

8 In Adobe Forms Designer, import the XML schema, and then map the schema to fields on the PDF 
form. For more information, see “Mapping the XML Schema to the PDF Form Using Adobe Designer” 
on page 31.

9 In the Siebel application, create a form record pointing to the PDF file. For more information, see 
“Creating the Form Record Referencing the PDF File” on page 32.

End-User Procedure
End users typically perform the following task to use Adobe forms integration:

■ Generate a form from the Siebel application record. A copy of the PDF form is stored in the 
Attachments view of the record. For more information, see “Generating a Form Using a Siebel 
Record (End User)” on page 34.
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Preparing for Adobe Form Integration 
Setup
You must perform the following preparatory steps before you can set up and use Adobe forms 
integration with your Siebel application. After you have verified that the tasks are complete, you can 
begin the forms integration tasks.

For more information on software version requirements for Adobe form integration, see System 
Requirements and Supported Platforms on Siebel SupportWeb. This definitive list of system 
requirements and supported third-party products is located on SupportWeb at Product 
Documentation > System Requirements and Supported Platforms & Miscellaneous Documentation. 

Figure 2. Adobe Forms Integration Process Flow
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This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To prepare for Adobe forms integration setup

1 Install Adobe Form Server. This server deploys high-volume, secure XML-based forms as 
Adobe PDFs to any platform. For installation instructions, see the documentation provided with 
the application. Adobe Forms Server requires that Java 2 SDK, SE, and IBM WebSphere be 
installed.

2 Install Adobe Designer. This form design tool allows creation of forms based on XML. 
Installation instructions are provided by Adobe for the application.

3 Install Adobe Acrobat Reader. Adobe Acrobat Reader software is used by end users to view 
and interact with forms and other PDF documents. Installation instructions are provided by 
Adobe for the application.

4 Install Adobe Plug-ins. Installation instructions are provided by Adobe for the plug-ins.

Creating the Web Service for Adobe 
Forms Integration
Using Siebel Tools, perform the steps in the following procedure to create the Web Service for Adobe 
forms integration. For more information, see Using Siebel Tools.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To create the Web Service

1 Launch Siebel Tools and log in as the administrator.

2 From the application level menu, choose File > New Object, and from the New Objects Wizard 
dialog box click the EAI tab and choose Web Service.

3 From the WSDL Import Wizard wizard screen, perform the following tasks:

a Select a project.

For example, select Contact as the project.

b Specify the WSDL document file from which to import. 

The WSDL document file is provided by Adobe.

After the WSDL document file is selected, the following field values are automatically 
populated. Do not change the default values.

Run-time data file: <path>\SiebelIntegration.xml

Log file: <path>\SiebelIntegration.log

c Click Next, and then click Finish.

4 Compile the project using Siebel Tools.
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Configuring the Web Service for Adobe 
Forms Integration
Complete the steps in the following procedure to configure the Web Service for Adobe forms 
integration.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To configure the Adobe Web Service

1 Navigate to the Administration - Web Services screen > Outbound Web Services view.

2 From the Outbound Web Services list, click the Import button.

3 From the EAI Web Service Import dialog box click Browse, locate the Adobe Web Service created 
in Siebel Tools (SiebelIntegration.XML) on the network, and then click Import.

4 In the Outbound Web Services list, select Adobe Web Service.

5 In the Service Ports list, update the address field with the correct IP address for the Adobe Form 
Server.

For example, the field should show an address similar to the following address:

http://255.255.255.0:9080/IDPWeb/IDPFormServer

Enabling Forms Integration for 
Additional Applets Using Siebel Tools
Adobe form integration is preconfigured as enabled on the following applets:

■ Contact List 

■ PUB Immigration Contact List

■ PUB Immigration Credentials List

■ PUB Immigration Identity List

■ PUB Immigration Identity Form

■ PUB Immigration Contact Identity Form

Forms can also be generated based on other business objects, such as opportunities. Administrators 
can add Adobe form integration functionality to other Siebel application applets using Siebel Tools. 
For more information, see Siebel Tools Online Help and Using Siebel Tools.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To add form integration functionality to application applets

1 In Siebel Tools, select the applet to which the forms integration menu option should be added.
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2 Add a new Applet Method Menu Item to the applet. In the Command field, select the Generate 
Form Command object.

Creating an Integration Object for 
Adobe Forms Integration
The following procedure provides information on how to create a new integration object for Adobe 
Forms Integration using Siebel Tools and the source object Contact. 

For more information about creating an integration object, see XML Reference: Siebel Enterprise 
Application Integration, Siebel Tools Online Help, and Using Siebel Tools.

NOTE: When creating the Siebel Integration Object for forms integration, make sure not to include 
fields that include a period (.) in the name. Adobe Designer does not support fields with the 
character.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To create an integration object

1 Launch Siebel Tools and log in as the administrator.

2 From Object Explorer, query for the project (for example, Contacts), and then lock the project.

3 From the application level menu, choose File > New Object, and from the New Objects Wizard 
dialog box click the EAI tab and choose Integration Object.

4 From the Integration Object Builder wizard screen:

a Select a project. 

For example, select Contact as the project.

b Specify the source system of the new Integration Object (business service) and then click Next.

For example, select EAI Siebel Wizard.

5 Select the source object for the new Integration Object from the list.

For example, select Contact.

6 Enter a name for the Integration Object.

For example, name the object Contact_Form_Integration. The name must be unique among all 
of the Integration Objects in Projects.

7 Choose the integration components that you would like to activate for the Integration Object by 
selecting the appropriate check boxes.

For example, expand the Contacts object hierarchy, and choose Contact_Personal Address, and 
Contact_Opportunity by selecting the check box for the appropriate item.

NOTE: Developers may want to include multiple integration components in building the 
integration object so that the integration object can be reused for many different forms. This also 
reduces the required maintenance for integration objects.
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8 Click Next, and then click Finish.

9 Select the integration object, right click the mouse, and choose Validate.

Generating an XML Schema for Forms 
Integration
Complete the steps in the following procedure to generate the XML schema. For more information, 
see XML Reference: Siebel Enterprise Application Integration.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To generate the schema for the forms integration object

1 From the Siebel Tools Object Explorer list, select the newly created integration object and click 
Generate Schema.

2 From the Generate XML Schema window, select a Business Service from the list.

For example, choose EAI XML XSD Generator.

3 In the Select an envelope type from the list field, select No Envelope.

4 In the Choose the file name to save the schema object field, click Browse, select the file to which 
you want to save, and then click Finish. 

The file must be saved on the network in a location where it can be accessed by the Siebel 
application at run time.

The XML Schema file, for example Contact_schema.xml, is generated, based on user inputs.

Mapping the XML Schema to the PDF 
Form Using Adobe Designer
Administrators can map the Siebel data schema to an Adobe PDF template using the drag-and-drop 
functionality provided with Adobe Designer software. For more information about using Adobe 
Designer 6.0, see the documentation provided with the Adobe application.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To map the schema to the PDF form

1 Launch Adobe Designer, and select the PDF file.

For example, launch Adobe Designer with a PDF file named Contact.pdf.

2 From the application-level menu, choose File > New Data Connection.

3 From the new Data Connection dialog box, select the XML Schema option and click Next.

4 From the next dialog box:
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a In the Select XML Schema field, browse for and open the XML schema file.

For example, open Contacts_schema.xml.

b Select the Embed XML Schema option.

c Click Finish.

5 Click the Data View tab and expand the node.

For example, expand the Contact node. You should see the schema columns under Contact, 
including child components, which may be selected during mapping.

6 In the PDF form, select the target field.

7 Drag the Siebel data column from the Data View, and drop it on the placeholder field in the PDF 
file.

For example, drag and drop Last Name, First Name, Cellular Phone, Home Phone, and so on.

8 Save the file.

NOTE: The PDF file with the mapped schema must be saved to the network location where it can 
be accessed by the Siebel application at run time.

Creating the Form Record Referencing 
the PDF File
Form records must be maintained within the Siebel application so that the forms are available to end 
users. This process allows administrators to add new forms, update forms with newer versions, and 
inactivate or remove old and obsolete forms.

Only users with administrator privileges may modify or delete form records. Typically older forms are 
flagged as inactive rather than deleted.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To create a form record

1 Navigate to the Administration - Document screen > Forms Integration Administration view.

2 In the Forms Integration list, create a new record, and provide a name and description.

For example, create a form record named Contacts.

3 Complete the fields, selecting the appropriate integration object.

The following table describes the fields.

Field Description Example

Version The version of the form. 1

Inactive Selecting this check box makes the 
form inactive
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Integration Object The integration object created or 
modified for forms integration.

Contact

Request Allows you to request files from the 
server. When a check mark appears 
in this field, the document is 
retrieved during the next 
synchronization session. This field 
only applies if you use Siebel 
Remote.

Update A check mark in this field indicates 
that you want your copy of the file to 
be updated automatically each time 
the original file is updated.

Business Object Automatically completed when you 
choose the integration object

Contact

File Name The name of the PDF file. Navigate 
to the file on the network.

Sample_Contact.pdf

File Type PDF Adobe’s Portable 
Document File format. 
The file type value is 
automatically populated 
when you select the file.

Type Indicates the document type in 
which the form is generated. PDF is 
the only supported option at this 
time.

PDF

Attachment Business 
Component

This field determines where the 
generated form is attached to the 
record.

Contact Attachment

Forms Adapter Choose Forms Integration PDF 
Adapter Service in most cases. 
Debug Forms Integration PDF 
Adapter can be used to troubleshoot 
issues with the Adobe integration.

Forms Integration PDF 
Adapter Service. 

File Adapter Choose Forms Integration File 
Adapter Service

Forms Integration File 
Adapter Service

Field Description Example
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Generating a Form Using a Siebel Record 
(End User)
Users can generate a PDF document that is automatically populated with data from a Siebel record 
such as a contact. The PDF file is stored in the Attachments view associated with the record.

This task is a step in “Process of Setting Up Adobe Forms Integration” on page 25.

To generate a form with data from a record

1 Navigate to the Contacts screen and select the appropriate record.

You can also create a new contact record and verify that the record contains the data necessary 
to populate the form.

2 From the Contacts list menu, select Generate Form.

The dialog box provides a list of forms associated with the parent business object.

3 From the Select Forms dialog box, choose the appropriate form by clicking the caret symbol on 
the left side of the list, and then click OK.

The end user is automatically navigated to the Attachments view of the record where the PDF 
file is stored for archiving purposes. The user can then drill into the hyperlink in the Attachment 
name form to open the document in Acrobat Reader.

4 Verify that the form is correctly populated with the data.

Attachment View The Attachment View determines to 
which view the user is navigated 
after the form is generated.

Contact Attachment view

Search Specification Allows the administrator to select 
certain information from the 
integration object’s child business 
component

To include information 
from a Contact's Account 
only if the account is 
Active, the value in the 
Search Specification field 
should be 
"[Contact_Account.Acco
unt Status] = 'Active' " 
where the Integration 
Component Name = 
Contact_Account.

Field Description Example
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Generation of Forms for Multiple Records
The procedure for generation of forms from multiple records, such as contacts, is performed the 
same way as for a single record.

When generating multiple forms, for example, for a Citizenship Ceremony, consider the complexity 
of the form and the number to be generated, and perform the task in batches.

For example, if the form is relatively simple, you can typically generate 200 forms at one time 
without impacting performance. If the form is complex, generate the forms in batches no greater 
than 100 forms at one time.
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5 Managing Benefits Cases
This chapter describes how social services and other municipal entitlement agencies can manage 
cases for benefits and services. It includes the following topics:

■ Scenarios for Benefits Case Management on page 38

■ Process of Managing Benefits Cases on page 39

■ Receiving a Benefits Request on page 40

■ Calculating Benefits Eligibility on page 42

■ Using Siebel SmartScript to Gather Benefits Assessment Information on page 42

■ Using eAdvisor to Manage a Benefits Eligibility Assessment on page 43

■ Assessment of Benefits Using Templates and Activities on page 43

■ Reviewing Benefits Case Details on page 44

■ Referring Cases to Third-Party Providers on page 45
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Scenarios for Benefits Case Management
These scenarios provide examples of benefit case management processes performed by agency 
employees, call center representatives and agency managers. Your agency may follow a different 
process according to its business requirements.

Referral Management
An intake agent at a Human Services Department receives a referral for rehabilitative services from 
a social services worker. The Human Services department employee also receives referral documents 
by mail from the customer’s doctor and other social services specialists. The referral information 
includes the customer’s personal information such as an address, the reason for the recommendation 
for services, and a brief description of the problem.

The intake agent creates the referral record, and routes it to a department manager. The department 
manager reviews the referral and assigns it to a field agent for an assessment. The field agent 
performs the initial assessment of the referral by talking to the social service worker, and the client.

Referral Intake
An intake agent at a Human Services Department meets with a customer seeking disability relief. 
The agent works with the customer to complete an electronic application for disability benefits. 

NOTE: An application for benefits or an eligibility inquiry also can be submitted electronically using 
a self-service Web site, by mail, or in person.

Referral Validation
The agent interviews the customer to obtain information such as earned income, other benefits 
income, assets and expenses, and additional pertinent application information. The agent creates a 
contact record for the customer and then creates a Household record to enter details about the 
customer’s family, income and assets.

The agent collects other important documents such as proof of residence, and employment 
verification that the customer has provided. Based on the investigation, the agent validates the 
referral, and moves it to the next step in the process.

Case Management
After the assessment is completed, the field agent updates the referral record, and, depending on 
the findings, the referral is converted to a case.

The case is approved, and is assigned to the case worker who manages the benefits package, case 
plan, and case outcome.

Case Record Creation
The agent then creates a case record, and provides the case number to the constituent for reference. 
In the case record the agent adds other details and associates scanned document files with the case 
record. The referral that led to this case is stored as a part of the case record. 
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Assignment of Cases to the Next-Level Agent
The agent assigns the case to a manager who assumes primary responsibility for coordinating 
assessment activities. Cases can either be assigned manually by adding another user to the Case 
Team field and selecting that user as primary, or by setting up an assignment rule, based on various 
criteria of the case record.

Assignment of Case Assessment Activities
A department manager at the Human Services Department provides a predefined assessment 
template that establishes evaluation criteria for the benefits application. The manager organizes a 
case team in the department to investigate various aspects of the application, assigns activities to 
each member of the team, and sets a due date for each assessment activity. The manager can 
automatically perform these tasks using assignment and workflow rules that are based on worker 
skills, availability, and on agency work processes.

Case Assessment
A field agent asks a customer relevant assessment questions, and captures the information. Based 
on the responses to the questions, the field agent can rule out ineligible customers, and can flag 
potential eligible customers for further review. The field agent completes the assigned assessment 
task, and creates a report. The field agent attaches the document to the assessment activity, updates 
the status of the activity, and then enters notes and observations that can be shared with the team. 
The manager reviews the assessment information, and changes the status of the case to eligible or 
not eligible. If the case is eligible, it is routed to a social worker.

Benefits Eligibility Determination
The benefits eligibility determination is based on individual details captured during the application 
intake process, and field agent assessment reports. The social worker uses the Siebel eligibility 
determination business process to calculate the customer's cash benefits along with non-cash 
benefits for a complete care package. The eligibility determination process typically involves 
integration with a third-party eligibility engine, financial or back-office system using Siebel Universal 
Application Network.

The social worker meets with the customer, and reviews the proposed benefits and services package. 
The customer signs the agreement, and the agent later scans the agreement to create a file that can 
be attached to the case record. The social worker updates the case, and the case is routed to the 
next-level manager for approval and payment authorization.

Process of Managing Benefits Cases
This section details sample tasks typically performed by end users when managing benefits cases. 
Your organization may follow a different process according to its business requirements. 

End-User Procedures
To manage a benefits case load, perform the following tasks:

1 Receiving a Benefits Request on page 40
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2 Creating a Case File During the Intake Process on page 41

3 Calculating Benefits Eligibility on page 42

4 Reviewing Benefits Case Details on page 44

5 Referring Cases to Third-Party Providers on page 45

Receiving a Benefits Request
During an interview with a customer requesting benefits, the call center representative or an intake 
agent typically creates a contact record and a household record to document household 
demographics and statistics. Before creating new records, the agent should query existing case files 
for other cases associated with the customer. If no related cases are found, the agent creates a new 
benefits request file. After the benefits request file is saved, it is routed manually, or using 
Assignment Manager to a benefits manager for review.

This task is a step in “Process of Managing Benefits Cases” on page 39.

Creating Contact and Household Records
Use the Contacts screen to search for existing contacts and create new contacts. Household 
information can either be entered using the Household field in the contact More Info view or from 
the Households screen. For more information on managing contact and household information, see 
Applications Administration Guide.

To create contact and household records

1 Navigate to the Contacts screen > Contacts Home view.

2 In the Contacts Add form, enter the customer’s name, and then click Add & Go.

3 From the Contact form, click the More Info view tab, and complete additional fields for the 
contact.

4 In the Contact form, click the select button in the Households field, and in the dialog box query 
for an existing Household, or click New to add a new household record. 

For a new record, complete the household Name, Type and Address, if necessary.

To associate additional household members with the contact

1 Navigate to the Households screen home page, and query for the household.

If you just created the household record, it appears in the Recent Records list.

2 Drill down on the household record to navigate to the Household Contacts view.

3 In the Household Contacts view, add additional contacts for the household.
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Contact and Household Screen Views
You can enter information on property and other assets, liabilities, and other relationships using the 
views associated with the contact and the contact’s household record. For example, you can use the 
Relationship Hierarchy view to provide a graphical hierarchy of the contact’s household.

For more information about creating contacts and households, see Applications Administration 
Guide.

Creating a Case File During the Intake 
Process
If warranted, the intake agent can create a customer case file which can then be routed to a manager 
for review. Case records can be created from the contact record as well as from the Cases screen.

This task is a step in “Process of Managing Benefits Cases” on page 39.

To add a new benefits case from the contact record

1 Navigate to the Contacts screen > Contacts Home view.

2 Using the Search form, query for the contact.

3 In the contact record, click the link in the Last Name field.

4 From the Contact form, click the Cases view tab.

5 In the Cases list, click New.

6 In the Cases dialog box, query for the case.

If the case does not exist, click New. 

NOTE: The application allows users to create multiple case records with the same case name. 
Case records are uniquely identified by the case number, which is automatically assigned to the 
case record.

When a case is created, the case status is set to active. The Date Opened field contains a case 
creation time stamp, and the primary team member, identified in the Team field, is, by default, 
the case record creator. Additional team members can be associated with the case.

7 In the Case record, name the case and select a value in the Sub-Status field.

For example, a substatus for a Benefits case might be Intake, Screening, or Referral.

8 In the Case Type field, select a value that describes the case type, and in the Stage field, select 
the case stage.

For example, the case type might be Entitlements, and the case stage might be Application.

To add details to the benefits case record

1 Navigate to the Cases screen > Cases Home view.

2 Query for the case.
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3 In the Case record, click the link in the Case Name field.

4 In the Case form, enter a description and then click on the appropriate view tabs to add details.

Calculating Benefits Eligibility
To determine a customer's eligibility for services, the field agent typically asks the customer a series 
of scripted questions and records the answers. Assessment information can be collected using 
Assessments, Siebel SmartScript or Siebel eAdvisor. These tools capture assessment data that is 
then used to match a customer with one or more benefit fulfillment programs. In instances where 
the rules governing benefits delivery are highly complex, integration to back-office calculation 
systems or eligibility determination systems is required.

The final eligibility determination is made by a qualified field agent or manager who completes the 
evaluation based on program rules. The benefits determination also can be made using Siebel UAN 
to integrate with existing legacy rules systems that determine benefits.

To perform assessments and determine benefits eligibility, you can employ the methods described in 
the following topics:

■ “Using Siebel SmartScript to Gather Benefits Assessment Information” on page 42

■ “Using eAdvisor to Manage a Benefits Eligibility Assessment” on page 43

■ “Assessment of Benefits Using Templates and Activities” on page 43

Using Siebel SmartScript to Gather Benefits Assessment 
Information
The process of assessing eligibility can begin with an electronic document or form created using 
Siebel SmartScript. The form includes input fields to collect information from users (yes or no, 
multiple choice, structured numeric, or text entry). Based on the information entered, the form 
logically presents options that can be used to gather additional information (branching logic). For 
more information on creating and implementing SmartScripts, see Siebel SmartScript Administration 
Guide. For configuring and activating SmartScripts, see Using Siebel Tools.

This task is a step in “Process of Managing Benefits Cases” on page 39.

To use SmartScript for an assessment

1 Navigate to the SmartScripts screen.

2 In the SmartScripts list, query for the Smartscript that is relevant to the call, and drill down on 
the link in the Name field.

3 In the SmartScript session, read the question to the customer and record the appropriate answer. 
At the conclusion of each question, click Next.
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4 After completing all the questions, click Finish to end the SmartScript session. 

The responses to the questions are captured and stored with the customer's Service Request 
record.

Using eAdvisor to Manage a Benefits Eligibility 
Assessment
Intake agents can administer assessment questions using eAdvisor as an eligibility assessment tool. 
This process may be used for discrete programs with clear guidelines where eligibility can be 
determined based on the answers to assessment questions. Final eligibility is often granted after the 
information given by the customer is verified as accurate and complete. This tool also can be used 
by a customer using a self-service Web site.

NOTE: Siebel eAdvisor is a separate module that customers may purchase for purposes of eligibility 
determination.

This task is a step in “Process of Managing Benefits Cases” on page 39.

To use eAdvisor for an Eligibility Assessment

1 Open the Siebel eAdvisor tool, and click on the Name of the appropriate assessment test.

2 Read the first question to the customer, and enter or select the appropriate answer. 

3 After each response, review the dynamic information being tracked on the right-side of the 
screen. 

If a question disqualifies the customer, inform the customer that they do not meet the criteria, 
and read the information provided with the disqualification message.

4 After a complete page of questions has been asked, click Continue to proceed with additional 
questions.

After completing all questions, the assessment test may provide a notification that the customer 
is potentially eligible. 

5 Click Continue to complete the customer's application on the next screen.

6 Click Submit after the requested application data for each field is completed.

Assessment of Benefits Using Templates and Activities
A manager can assign benefits and services assessment activities to field agents on the team. The 
activity plan specifies the list of activities (the business processes) that must be completed by the 
agents working on a case. For example, the activity plan for a case might include an assessment 
activity to determine if the benefits application is complete. The agent assigned the activity might 
use a predefined assessment template to complete the task.
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Assessment templates with associated attributes are set up using the Administration - Data screen’s 
Sales Assessment Templates view. Activity plans with associated activities are set up using the 
Administration - Data screen’s Activity Templates view.

An assessment is a set of questions that can be used to evaluate a case. For example, assessment 
questions might include the following:

■ Does the application meet the basic criteria for acceptance?

■ Did the applicant provide sufficient evidence to support receiving benefits?

■ Are additional evaluations required?

■ Has the case reached a point where it should be closed?

The agent assigned the activity might begin the activity by opening the case record, and associating 
a predefined assessment template with the case. Most assessments can be completed using the Case 
Assessments view. For those assessments that are more complex, or that require a specific form to 
be completed, the agency can create a report and attach the report and supporting documentation 
to the case record. Alternatively, Siebel SmartScript and Siebel eAdvisor can be used to manage 
more complex assessments, and automatically match data to program criteria.

The agent conducting an assessment of the customer’s information might verify employment and 
household information, assets and liabilities, and medical diagnoses. A personal interview with the 
customer may be warranted. Siebel UAN functionality can be used by agencies to verify information 
such as Social Security numbers and employment records from other agencies. 

For information on creating assessment templates with attributes, see Applications Administration 
Guide.

Reviewing Benefits Case Details
After the intake process is completed, new cases can be manually or automatically routed to a 
manager for review and approval using a workflow process. The manager sees pending cases in the 
MyCases list and then clicks the link for each new case record to review details.

This task is a step in “Process of Managing Benefits Cases” on page 39.

To review the details of a benefits case

1 From the home page, review the data in the My Cases list, and click on the column headings to 
sort, if necessary.

2 In the case record, click the link in the Case Name field to get additional details about that case. 
You can also click the My Cases link at the top of the page to review all of your cases.

3 From the Case form, click the associated view tabs to review attachments and other case related 
information.

For example, the Attachments view might include supporting documentation verifying a 
disability.
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Referring Cases to Third-Party Providers
Many agencies contract with third-party providers to manage cases that have met eligibility criteria. 
The agent or manager who approves the case can set the case status to Third-Party, and use manual 
or automatic routing tools to forward the case to a partner agent. Only information that is authorized 
for the third-party is available by means of a secure Internet-based Siebel Partner Relationship 
Management portal.

After the case is routed, the partner agent logs on to a Partner Portal, reviews new cases (flagged 
with an asterisk), and begin work on these cases. As the partner agent makes progress on the case, 
the agency can view case status, documentation, and other relevant information. As a result, the 
agency can maintain oversight and access to real-time information on work being completed by 
partner agents.

This task is a step in “Process of Managing Benefits Cases” on page 39.

Assigning a Case to a Partner Provider
The assignment of a referral to an expert for assessment is accomplished manually, or automatically, 
using Assignment Manager. To refer a case to a partner provider, the government agency employee 
making the referral must add the partner agent receiving the referral to the case team.

To assign a case to a partner provider

1 Navigate to the Cases screen, and query for the case.

2 In the case record, add the partner agent who is receiving the case referral the Case Team.

3 Save the record.

When the partner agent logs into the Partner Portal application, the newly assigned case appears 
under that agent’s myCases list.

Reviewing Referred Cases
The partner agent can accept and manage the case using this process.

To review newly assigned partner provider cases

1 Log into the Partner Portal with an established user name and password.

2 Navigate to the Cases screen > Cases List and review the list of cases. 

An asterisk appears in the New field for newly assigned cases.

3 In the case record, click the link in the Case Name field.

4 From the case details form, click the appropriate view tab.

The partner agent can review assigned Activities, Attachments, related Service Requests, and 
Notes.
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6 Managing Investigative Cases
This chapter describes how Federal and municipal law enforcement agencies and emergency 
response teams can track and manage leads, incidents and case information, and develop suspect 
and group profiles that can be shared by investigative teams managing cases. It includes the 
following topics:

■ Scenarios for Investigative Case Management on page 48

■ Process of Managing Investigative Cases on page 49

■ Creating an Incident Report on page 50

■ Developing a Case for an Investigation on page 52

■ Creating Suspect Profiles for an Investigation on page 55

■ Creating Group Profiles for an Investigation on page 57

■ Creating Accounts and Contacts for Sharing Case Information on page 58
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Scenarios for Investigative Case 
Management
The following scenarios provide examples of a processes performed by agency call center personnel, 
investigators, and case managers. Your agency may follow a different process according to its 
business requirements.

Incident and Case Management
A police department dispatcher receives a call from a local citizen who wants to report a disruptive 
gathering at a nearby home. The operator creates an incident report and assigns an incident 
investigator.

The police department dispatcher receives a second call from an anonymous caller reporting 
gunshots near the location of the earlier disturbance. The dispatcher creates a second incident 
report, and then, based on information provided by the caller, creates a suspect record and a group 
record associates them with the incident. Since the incident involves a potential threat to public 
safety, the dispatcher sends an investigator. 

The investigator follows up on the incident, finds several persons have been injured, and determines 
that the incident should be escalated to a case. From the incident record, the investigator creates a 
case record and attaches several digital photos from the crime scene to the case record. He records 
the activities that he completed while on the scene, and adds a public note sharing details gained 
from interviews with his team, and then adds a private note based on an unverified tip.

The investigator queries his team's open caseload for other cases associated with the same group. 
He finds several other cases which are being worked by another team member. The investigator 
associates his case with those of the team member. The two investigators confer to decide which of 
them should be listed as the primary investigator for the case.

Suspect and Group Management
A senior detective with a municipal police department is investigating a local gang in connection with 
a series of homicides. He receives word from a colleague that a suspect in a recent shooting incident 
may have ties to the gang that the detective is investigating. The detective reviews the shooting case 
and notes that witnesses identified the suspect using an obvious alias. The detective searches the 
suspects database for the alias and finds a match, confirming that an individual using the alias and 
matching the suspect’s description, is associated with a gang believed to be involved in several 
shooting cases.

The detective accesses the gang’s group record and reviews the hierarchy to determine the 
relationship that the suspect has with other gang members. He finds that one of the suspect’s 
subordinates was a previous shooting victim. The detective uses an informant to gathers additional 
information, placing the suspect at the recent incident at the time of the shooting. The detective 
determines that the suspect may have had a motive and the opportunity to commit the previous 
night's crime. The investigator updates the suspect record with the activities he has performed and 
the notes he has gathered, and then generates a Case Overview Report about the shooting 
investigation to use in requesting a warrant for the suspect’s arrest.
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Process of Managing Investigative Cases
This section details sample tasks often performed by end users when managing investigative cases. 
Your agency may follow a different process according to its business requirements.

End-User Procedures
The following list shows tasks end users perform to manage an investigative case:

1 Creating an Incident Report on page 50

2 Developing a Case for an Investigation on page 52

3 Escalating an Incident to a Case for Investigation on page 52

4 Adding Case Details and Scheduling Follow-Up Activities on page 54

5 Creating Suspect Profiles for an Investigation on page 55

6 Adding Suspect Details and Scheduling Follow-Up Activities on page 56

7 Creating Group Profiles for an Investigation on page 57

8 Adding Details to a Group Profile on page 58

9 Creating Accounts and Contacts for Sharing Case Information on page 58
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Creating an Incident Report
An incident represents the information received about an event that may be of interest to the 
government agency. An incident can be a report of a leaking fire hydrant, or a lead in a case 
investigation. Incident information can be received by phone call, email, faxes or generated through 
independent research.

Incident records may be automatically created based on the content of incoming messages and 
emails. A member of the investigative team is usually assigned the responsibility to follow up on the 
incident information to determine if the incident warrants further action and whether or not the 
incident is associated with other incident reports, leads and cases in the system. Based on the 
particular agency’s criteria, the agency may determine that an incident should be upgraded to a case.

From the Incidents list, investigators can view incident records created by individuals on the team.

This task is a step in “Process of Managing Investigative Cases” on page 49. It includes the following 
related procedures:

■ “Adding Details to an Incident” on page 51

■ “Escalating an Incident to a Case for Investigation” on page 52

To create an incident record

1 Navigate to the Incidents screen > Incidents Home view.

2 Using the Add form create an Incident record, and click Add & Go.

3 In the Incident Details form, complete the fields, and then save the record.

The following table describes some of the fields.

Field Comments

Incident Number Automatically generated identifier.

Employee The employees assigned to the incident. Defaults to the record creator.

Status Status of the incident. Example of status are In Progress, Dispatched, 
Active.

Priority A value that indicates the importance of incident investigation.

Location The location of the incident. Select the location from a predefined list or 
enter the information directly in the field.

Case Used to associate the incident with a new or existing case record.

Suspect Used to associate the incident with a new or existing suspect record.

Group Used to associate the incident with a new or existing group record.

Keywords Words that can be used to search for similar incident characteristics.

Date Occurred The date of the incident.

Date Created Automatically populated when the incident record is created.
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Adding Details to an Incident
An agency investigator or call center employee can add more detail to an incident record by 
specifying suspects and groups that may be associated with the incident and using the Attachments 
and Notes views to add documents and other external media to the record. Using the Activities view, 
the investigator can provide a history of actions performed to resolve the incident.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To add details and supporting documentation to an incident

1 Navigate to the Incidents screen > Incidents Home view.

2 Search for the Incidents, and in the incident record click the link in the incident Name field.

3 From the Incident form, click the appropriate view tab and create a new record.

The following table describes some of the views.

Source Name The contact who provided the information. If the contact does not exist 
in the system, create a new contact record.

Source Type The information source used to report the incident (email, phone, fax, 
news media, open source, other).

Source 
Organization

The source organization for the incident information.

Source Reliability  This field is automatically populated if the Contact record contains a 
value for reliability.

Incident 
Description

A text description of the incident.

View Description

Activities If an incident requires follow up activities, use this view to create investigative 
tasks with alarms and assign each activity to a team member. Typical activity 
types are arrest, diagnosis, communication, subpoena, surveillance, and so on. 
Use the Activity Type field to further define the activity. Use the Employees field 
to specify each team member assigned to the activity. Selecting the Primary 
field for an employee record identifies the lead individual on the team.

Attachments Use this view to associate documents, images and other media with the 
incident. Use the Comments field to describe the attachment.

Groups Use this view to associate existing Group records with an incident or create a 
new group record. You can associate more than one group with an incident.

Field Comments
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Escalating an Incident to a Case for Investigation
If an incident warrants immediate escalation to a case investigation, a case file can be generated 
from the Incident record.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To create a case from an incident

1 Navigate to the Incidents screen > Incidents Home, and query for the incident.

2 In the Incidents record, click the link in the Name field.

3 Select the More Info view tab, and then click Create Case.

The new case appears in the My Cases list.

If a case has already been created from this incident, an advisory message appears. Click 
Continue to navigate to the case record. Click Cancel to return to the incident record.

Developing a Case for an Investigation
If an incident requires further investigation, it is escalated to a case file. Investigators can create a 
case from an incident record’s More Info form, and they can create cases unrelated to incidents, 
using the Cases screen.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To create a case record

1 Navigate to the Cases screen > Case List view.

2 In the Cases list, create a record, and complete the fields.

Notes Use this view to add information such as directions to the incident site and 
references. Select Public to make the note will be available to team members 
and Private if the note is not shared.

Suspects Use this view to associate existing Suspect records with an incident, or create a 
new suspect record. You can associate more than one suspect with an incident. 
To indicate that a suspect is the primary individual of interest, click the Primary 
field in the record.

View Description
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3 In the Case form, enter additional case details.

The following table describes some of the fields.

Field Comments

Name Descriptive name for the case.

Case Number Automatically generated unique number.

Status The status of the case indicates whether the case is still being worked. 
Values include Active, Closed, and Inactive. The default value for a new 
case is Active. When the Status is set to Closed, all other fields in the case 
record become read-only.

Sub-Status Used to further define the case status. For example, for cases with a 
Status of Active, the choices for substatus could be Appealed, Intake, 
Screening, Referral, and Assessment.

Team The owner and members of the team assigned to the case. Defaults to the 
case record creator.

Type The kind of case that is being processed. Case types typically are specific 
to the agency deploying Siebel Public Sector. Examples are Fraud, 
Organized Crime, and Public Health.

Stage Used to define the step in the process lifecycle for the case. Examples are 
Intake, Investigation, and Screening. 

Suspect A list of available suspects. You can also create a new suspect record.

Group A list of available groups. You can also create a new group record.

Reward Remuneration associated with case information.

Date Opened Automatically completed with the date and time the case record is 
created.

Date Closed Date and time the case is closed.

Threat Type Used to group similar threats. Examples are Murder, Kidnapping, and 
Cybercrime.

Threat Sub-Type Used to further define the threat, based on the threat type. The values in 
this list are dependent on the value selected in the Threat Type field.

Threat Level Predefined levels used to escalate threat. Examples are High, Medium, 
and Low.

Classification Classifications include Unclassified, Classified, Secret, and Top Secret. 

Description Text field for additional information. Click Check Spelling to verify spelling 
in the Case Description field.
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Adding Case Details and Scheduling Follow-Up Activities
A number of views associated with the case record allow members of the case team to add supporting 
documentation and activities to a case record. The Audit Trail view tracks changes to the case record.

To add details and supporting documentation to a case

1 Navigate to the Cases screen > Cases Home view, and query for the case.

2 In the case record click the link in the Name field.

3 Click the appropriate view tab and create a new record.

The following table describes some of the views.

View Description

Activities If a case requires follow up activities, use this view to create investigative 
tasks with alarms and assign each activity to a team member. Typical 
activity types are incident, arrest, diagnosis, meeting, and so on. Use the 
Activity Type field to further define the activity. Use the Employees field to 
specify each team member assigned to the activity. Selecting the Primary 
field for an employee record identifies the lead individual on the team.

Activity Plans Use this view to associate a predefined activity plan with associated 
activities to the case. 

Attachments Use this view to associate documents, images and other media with the 
incident. Use the comments field to describe the attachment.

Audit Trail Use this view to determine who has modified the case record and when the 
changes were made.

Calendar Use this view to manage case-related appointments and tasks.

Contacts Use this view to associate individuals with the case.

Diseases Use this view to associate a disease or medical condition with the case.

Groups Use this view to associate existing Group records with an incident or create 
a new group record. You can associate more than one group with an 
incident.

Incidents Use this view to associate one or more incidents with the case.

Notes Use this view to add information such as directions to the incident site and 
references. Select Public to make the note available to team members and 
Private if the note should not be shared.

Related Cases Use this view to associate other case records with the case.

Service 
Requests

Use this view to initiate a request for action or service fulfillment. An 
example is a request for records transfer (such as a cold case file) from 
another agency or a request for additional research information by another 
agency.
Siebel Public Sector Guide Version 7.854 



Managing Investigative Cases ■ Creating Suspect Profiles for an Investigation
Creating Suspect Profiles for an 
Investigation
Suspect records provide profile information on individuals believed to be associated with unlawful 
acts. Suspects can be associated with incidents, cases, groups, and other investigative data.

When investigating an incident, the agency team maintains a comprehensive history of activities and 
associates documents and other media to the suspect record. These notes are important when 
building a case and can help the investigation team avoid duplication of effort.

Activities and Suspect Profiles
While conducting research on a suspect, an investigator might call a police department to follow up 
on an incident associated with the suspect. After the call is completed, the investigator creates an 
activity record to record the event. Activities also can be tasks or to-do items that need to be 
completed in the future. These items can be flagged to order their appearance as to-do items on the 
user's calendar. For more information on creating activities, see Applications Administration Guide.

Attachments and Suspect Profiles
Any type of media (files, pictures, reports, Internet queries, and so on) can be associated with a 
suspect profile, as well as with an incidents, cases, events, advisories, and groups. Attachments are 
useful in building an electronic case folder so that all parties in the investigation can share 
information.

Notes and Suspect Profiles
Notes are used to maintain important information about incidents and suspects and can be viewed 
by users. All users can view Public notes. Private notes can only be viewed by the user who created 
the note.

Procedure
Use the following procedure to create a suspect profile for an investigative case.

This task is a step in “Process of Managing Investigative Cases” on page 49.

Suspects Use this view to associate existing suspect records with a case or create a 
new suspect record. You can associate more than one suspect with a case. 
To indicate that the person is the primary individual of interest, click the 
Primary field in the suspect record.

Vehicle Use this view to document characteristics of vehicles owned by individuals 
associated with the case.

View Description
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To create a suspect profile for an investigative case

1 Navigate to the Suspects screen.

2 In the Suspects list create a new record, and complete the fields.

3 In the Suspect form, enter additional details and comments, and then save the record.

Adding Suspect Details and Scheduling Follow-Up 
Activities
Using the Suspect screen views, the investigator can document relationships, groups and addresses 
associated with the individual. Investigators can also link the suspect to incidents and cases, add 
attachments, and develop activities to broaden the scope of the suspect file.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To add details to a suspect record and schedule follow-up activities

1 Navigate to the Suspects screen.

2 In the Suspects list, query for the suspect record, and click the link in the Last Name field.

3 From the Suspect form, click the appropriate view tab.

The following table describes some of the views.

View Description

Activities If a case requires follow up activities, use this view to create investigative 
tasks with alarms and assign each activity to a team member. Typical activity 
types are incident, arrest, diagnosis, meeting, and so on. Use the Activity 
Type field to further define the activity. Use the Employees field to specify 
each team member assigned to the activity. Selecting the Primary field for an 
employee record identifies the lead individual on the team.

Addresses Use this view to document all known addresses for the suspect or to create 
a new address. Click the primary field to flag the primary address.

Attachments Use this view to associate documents, images and other media with the 
suspect. Use the comments field to describe the attachment. The New File 
and New URL buttons allow users to choose the file or the URL that is added 
to the record.

Cases Use this view to associate new cases with the suspect or review an existing 
case history.

Groups Use this view to associate existing Group records with a suspect or create a 
new Group record. You can associate more than one group with a suspect.

Incidents Use this view to associate one or more incidents with the suspect.
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Creating Group Profiles for an 
Investigation
A group record provides profile information on international and domestic organizations. Groups can 
be associated with incidents, cases, events, references, and advisories.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To create a group record

1 Navigate to the Groups screen.

2 In the Groups list, add a record.

3 In the new record, complete the fields.

The following table describes some of the fields.

Relationships Use this view to provide details on individuals who associate with the suspect.

Notes Use this view to add other information to the suspect record. Select Public to 
make the note available to team members and Private if the note is not 
shared. Click Check Spelling to perform a spell check on Notes text.

Field Comments

Name The name or alias of the group.

Status The group status is Active or Inactive.

Parent Group The name of the parent group if applicable. The parent group record must 
already exist.

Associated 
Groups

The names of other groups affiliated with the group being created.

Threat The type of threat, for example, Armed Robbery, Biological Weapons, 
Chemical Weapons, Cybercrime, Kidnapping, Murder, Nuclear Weapons, or 
Other.

Membership The estimated number of members in the group.

Leader The leader of the group. You can select the leader from the list of suspects 
previously associated with the group.

Description Text field for entry of other information about the group.

Team Primary member of the investigative team. Defaults to the user ID of the 
individual creating the group record. Other team members can be added, 
but only one member can be designated as the primary.

View Description
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Adding Details to a Group Profile
Investigators can use the Group screen and views to add notes and attachments, visualize the 
hierarchy of the group, link the group to incidents, cases and suspects, and schedule follow-up 
activities.

To add details to a group record and schedule follow-up activities

1 Navigate to the Groups screen.

2 In the Groups list, select the group record, and click the link in the Name field.

3 From the Group form, click the appropriate view tab.

The following table describes some of the views.

Creating Accounts and Contacts for 
Sharing Case Information
Account profile data is maintained on public and private sector organizations and used for notification 
purposes. Using the Accounts screen, you can create a repository of agencies and organizations.

View Description

Activities If follow up activities, use this view to create investigative tasks with alarms 
and assign each activity to a team member. Typical activity types are fraud 
action, Internet lead, diagnosis, meeting, and so on. Use the Description and 
Comments fields to further define the activity. You can also associate 
suspects and cases with a Group activity.

Addresses Use this view to document all known addresses for the group or to create a 
new address. Click the primary field to flag the primary address.

Attachments Use this view to associate documents, images and other media with the 
suspect. Use the comments field to describe the attachment.

Cases Use this view to associate existing cases with the group or review the group's 
case history.

Hierarchy If you have specified a parent group and associated suspects and groups, 
you can see a graphic representation of the group hierarchy.

Incidents Use this view to associate one or more incidents with the group.

Notes Use this view to add other information to the group record. Select Public 
Notes to make the note available to team members and Private if the note is 
not shared. Click Check Spelling to perform a spell check on note text in the 
Description field.

Suspects Use this view to associate suspects with the group.
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Contact information can be maintained on public and private sector individuals such as police chiefs, 
sheriffs, public information agencies, and emergency response personnel. This information can be 
useful to support notification and correspondence processes involved in either an incident or case.

This task is a step in “Process of Managing Investigative Cases” on page 49.

To create account and contact information

1 Navigate to the Accounts or Contacts screen > Home view.

2 In the Search form, search for an existing account or contact.

3 If the contact or account is not found, create a new record using the Add form, and then click 
Add & Go.

To locate an agency employee

1 Navigate to the Employees screen.

2 In the Employees list, query for the employee.
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7 Managing Health Threats and 
Response
Federal and municipal public health agencies can track disease outbreaks, share information 
internally and with the public, and manage local and global response using the Diseases screen.

This chapter describes the procedures needed to track disease outbreaks and medication availability, 
develop frequently asked question (FAQ) solutions, and manage response. It includes the following 
topics:

■ Scenario for Health Threat and Response Management on page 62

■ Process of Managing Public Health Cases on page 63

■ Creating a Disease Record on page 63

■ Developing Disease Details on page 64

■ Managing Disease Response Inventory on page 65

■ Managing Calls on Suspected Health Threats on page 67

■ Searching for Information on Health Topics on page 67

■ Creating and Modifying Health Topic Content on page 68

■ Contributing to and Approving Content for Health Topics on page 68
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Scenario for Health Threat and Response 
Management
This scenario provides an example of a process performed by public health agency managers. Your 
agency may follow a different process according to its business requirements.

An epidemiologist with a Disease Control Agency (DCA) receives reports of an outbreak of 
monkeypox in humans from doctors in the southwestern states. Compiling information from reports 
as well as from research completed by lab colleagues, the epidemiologist creates a new disease 
record which includes an overview of the disease, a diagnosis, the disease symptoms, and public 
health response procedures. In the disease record, the epidemiologist identifies three of her 
colleagues, who specialize in animal-transmitted diseases, as disease experts. 

The epidemiologist begins tracking the spread of the disease and creates case records for each of 
the doctors that contacted her about a disease outbreak. The epidemiologist also attaches several 
recent news articles about the disease to the disease record.

The epidemiologist creates several Frequently Asked Questions documents (FAQs) for publication to 
provide accurate information to the public about the disease. After finalizing the content of the FAQs, 
the epidemiologist publishes them on the DCA Web site.

Several weeks later, a biomedical company announces that it has developed a human vaccine for 
monkeypox. The epidemiologist creates a medication record for monkeypox vaccine and enters the 
details provided by the company. The epidemiologist associates the vaccine with the monkeypox 
disease record. 

The epidemiologist arranges for a shipment of 1,000 units of the vaccine from the biomedical 
company to the DCA warehouse and creates an inventory transaction record to document the 
delivery of the vaccine. After the vaccine arrives, the epidemiologist initiates another inventory 
transaction to transfer 250 units of monkeypox vaccine to an affected state’s Health Department, in 
response to the monkeypox outbreak in that state.

Updating the Disease Knowledge Base
At a DCA call center, an agent receives a call regarding monkeypox from a physician in Colorado. The 
agent creates a service request to record the incident reported by the doctor, a description of the 
patient’s symptoms, and contact information for the physician’s office. The agent then searches the 
knowledgebase for FAQs and a document to send the doctor.

After reviewing the information with the doctor, the agent discovers a question that is not covered 
by the DCA’s current documentation. The agent offers to call the physician back, and escalates the 
new question to a manager.

The manager contacts the epidemiologist to research the question. The epidemiologist updates the 
FAQ with the new information, and releases it to the call center manager. The call center manager 
posts the new FAQ information, and alerts the agent about the new information. The agent calls the 
primary contact at the doctor’s office, delivers the new information, and closes the request. 
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Process of Managing Public Health Cases
This section details sample tasks often performed by end users when managing public health 
information and cases. Your organization may follow a different process according to its business 
requirements.

End-User Procedures
The following list shows tasks end users typically perform to manage public health cases.

1 Creating a Disease Record on page 63

2 Developing Disease Details on page 64

3 Managing Disease Response Inventory on page 65

4 Managing Calls on Suspected Health Threats on page 67

5 Searching for Information on Health Topics on page 67

6 Creating and Modifying Health Topic Content on page 68

7 Contributing to and Approving Content for Health Topics on page 68

Creating a Disease Record
Public Health managers and other medical professionals create disease records with related 
informational files. For example, a disease record may be associated with one or more of the 
following:

■ Case records detailing individual or group outbreaks

■ Frequently-asked questions (FAQs) about the disease that may be published as well as used 
internally

■ Medications, with dosage information

■ Service requests

■ Training courses on disease management or epidemiology

■ Attachments, such as digital X-ray files, photos of symptoms, and microscopic renderings

Related Topic
Developing Disease Details on page 64.

This task is a step in “Process of Managing Public Health Cases” on page 63.

To create a disease record

1 Navigate to the Diseases screen.

2 In the Diseases list, create a record.
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3 In the Disease Details form, complete the fields, and then save the record.

The following table describes some of the fields.

Developing Disease Details
After a disease record is created, public health officials can use the associated views to develop 
details on cases and medications, publish FAQs and solutions documents on internal and external 
Web sites, associate media such as report documents and photographs with the record, and specify 
training courses.

This task is a step in “Process of Managing Public Health Cases” on page 63.

Field Comments

Name The name of the disease.

Status The current status of the disease worldwide. Options are Active, Current 
Outbreak, Eliminated, and Rare.

Category Some options include Biological -A, B and C; Chemical - Blister/
Vesicants, Chemical - Blood, Chemical - Choking/Lung, and so on. 
Administrators can set the category LOV values.

Expert The in-house expert on this disease. The default is the user ID of the 
person creating the record.

Overview A high-level abstract of the disease.

Diagnosis The methods, signs, and symptoms by which a disease is identified.

Symptoms The biological manifestations that indicate the presence of the disease.

Response Recommended precautions to curtail spread of the disease.

Incubation Period The period between the infection of an individual by a pathogen, and the 
manifestation of the disease it causes.

Surveillance When the check box is selected, the disease is tracked. The agency must 
define a workflow that specifies what happens when cases are created 
against disease records flagged for Surveillance. The workflow could 
result in raising the priority of the case, sending notification, and so on. 
For more information on workflows, see Siebel Business Process 
Designer Administration Guide.

Last Updated Automatically populated.
Siebel Public Sector Guide Version 7.864 



Managing Health Threats and Response ■ Managing Disease Response Inventory
Table 4 describes the views associated with a disease record:

Managing Disease Response Inventory
Inventory locations are used to identify where products are stored and the source from which the 
product is fulfilled. Public Health professionals add inventory locations and then manage the 
inventory at each location to increase efficiency when responding to a public health crisis. Health 
professionals use the inventory transactions screen to move inventory such as vaccines and medical 
equipment from one location to another.

For more information on setting up locations, see Applications Administration Guide. For information 
on managing inventory, inventory transactions and locations, see Siebel Field Service Guide.

This task is a step in “Process of Managing Public Health Cases” on page 63.

To set up disease response inventory locations

1 Navigate to the Inventory screen.

2 In the Inventory Locations list, add a record and complete the fields.

3 In the Inventory Location record, click the link in the Name field.

Table 4. Views Associated with the Disease Screen

Views Description

Attachments Use this view to associate electronic files such as documents and images to the 
disease record. 

Cases Use this view to create cases associated with the disease. To create activities 
associated with the cases, click the link in the case Name field.

FAQs Use this view to access predefined solution files. Click the link in the Name field 
to add solution files. To create solution files, navigate to the Administration - 
Solutions screen where you can create solutions associated with frequently 
asked questions. For more information on creating solutions, see Siebel Field 
Service Guide.

Medications Use this view to associate medications with the disease record. The medication 
record may include information on drug interactions, other applications, and 
acceptable substitutes. 

Service Requests Use this view to log service requests. An agency can use service requests to 
track health complaints, determine if similar complaints exists, and escalate to 
a case.

Training Use this view to associate professional course work that can help prepare public 
health emergency personnel to respond in an emergency and provide medical 
training. 
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4 From the Inventory Location form, click the appropriate view tab to enter inventory details.

For example, click the Product Inventory view tab, add a record, and complete the details for the 
product, the inventory level, and assets associated with the product.

To manage medical inventory transactions

1 Navigate to the Inventory Transactions screen.

2 In the All Inventory Transaction list, create a record, and complete the fields.

The table that follows describes some of the fields.

Field Comments

Type Options include Adjustment, Allocate, Over-the-Counter, and so 
on.

Product The name of the product in inventory.

Part # Automatically populated when the product is selected.

Serialized Automatically populated, if applicable, when the product is 
selected.

Quantity The number of items in the transaction.

Organization The owner of the product.

Comments Optional instructions and information about the transaction.

Source 
Location

The location of the inventory items.

Source 
Availability

Options include Customer-Owned, In-Transit, and Reserved.

Source Status Options are Good and Defective.

Destination 
Location

The destination location for the transaction inventory.

Destination 
Availability

Options include Customer-Owned, In-Transit, On-Hand, On 
Order, and Reserved.

Destination 
Status

Options are Good and Defective.

Commit Check box indicates whether or not the transaction was 
committed.

Transaction # Unique system-issued identifier when the transaction record is 
created.

Transaction 
Date / Time

Automatically date stamped when the transaction record is 
created.
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Managing Calls on Suspected Health 
Threats
Public health call center agents accept inbound calls that appear as a flashing icon on the CTI toolbar. 
After accepting the call, the agent creates the service request and captures details about the call.

This task is a step in the “Process of Managing Public Health Cases” on page 63.

To manage health threat calls

1 Navigate to the Service screen > Service Request List view.

2 In the Service Requests list, create a new record and add details, including a Summary of the 
call, and the Last Name of the caller.

3 Expand the Service Request form using the show more button.

4 In the Other Information section of the form, associate a Disease with the record, as well as any 
additional necessary details.

Searching for Information on Health 
Topics
Public health call center agents search for information to provide to callers using a knowledgebase 
containing FAQs, documents, and information. When information is incomplete or missing, agents 
escalate a request for information to public health specialist. New content is created, approved, and 
released for use by the agents.

This task is a step in the “Process of Managing Public Health Cases” on page 63.

To search for health information

1 From the tool bar at the top of any screen, click the Search icon (binoculars) to begin the search.

2 In the Search form, select Diseases in the Look In field.

3 In the Name field, enter the name of the disease, and then click Search.

4 In the Results view, select the record, and then click the link in the disease Name field.

This action highlights the disease record in the All Diseases list.

Close the Search view if desired.

5 In the All Diseases view, select the disease record and then click the link in the Name field.

6 From the disease details form, click the appropriate view tab to access Attachments, Cases, 
FAQs, Medications, Service Requests, and Training associated with the disease.

7 Click the FAQs view tab, and locate the appropriate item for the customer's request in the list.

8 Open the FAQ by clicking the link in the Name field.
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Creating and Modifying Health Topic 
Content
As agents receive unanticipated questions about health topics, they alert managers to the need for 
new content. The manager has administrative authority to create content projects to add or update 
items in the content library.

For more information on Content Management, see topics on Content Center in Siebel Content 
Publishing Guide.

This task is a step in the “Process of Managing Public Health Cases” on page 63. 

Related topics
Contributing to and Approving Content for Health Topics on page 68

To create and modify public health topic content

1 Navigate to the Administration - Solution screen > Solutions view.

2 In the Solutions list (or form), add a new record, and specify the Name, FAQ, and Description.

The description is the answer to the question.

3 In the Solution record, click the link in the Solution Name field.

4 Click the Resolution Documents view tab, and add any relevant attachments.

5 Categorize the solution, as appropriate, using the Solution Categories view.

6 When the solution is complete, update the Status from Draft to Final, and select the check boxes 
for Publish Internal and Publish External, as appropriate. 

Publish Internal shares the solution with appropriate Siebel users, while Publish External makes 
the solution available on the Siebel customer Web application.

7 Navigate to the Diseases screen, and query for the disease.

8 In the Disease record, click the link in the Disease Name field, and navigate to the Disease FAQs 
view.

9 In the Disease FAQs list, create a new record and associate the newly created Solution with the 
Disease record.

Contributing to and Approving Content 
for Health Topics
Producing health topics is a collaborative project. Some employees are responsible for writing the 
content, others for editing it, and still others for approving (or signing-off) on the content. 
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To create, edit, and approve health topic content
■ Use the Content Center. 

For information about Content Center, see Siebel Content Publishing Guide.
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8 Managing Tax Cases
Tax and revenue agencies at the federal, state, and at the local level can use Siebel Public Sector to 
track and manage service requests, as well as audits, appeals, and collection cases. This chapter 
describes how to use Siebel Public Sector to manage tax cases. It includes the following topics:

■ Scenarios for Tax Case Management on page 72

■ Process of Managing Tax Cases on page 73

■ Working with Tax Case Files on page 73

■ Adding Case Attachments and Notes on page 74

■ Managing the Case Calendar and Activities on page 75

■ Tax Case Assessment Tasks on page 76

■ Routing and Assignment of a Tax Case on page 76

■ Associating a Contact or a Partner with a Case on page 77

■ Case Correspondence Management on page 77

■ Tracking Case Status on page 78

■ Closing and Reopening a Case on page 78
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Scenarios for Tax Case Management
The following scenarios provide examples of processes performed by tax agency call center 
representatives, case workers, and managers. Your agency may follow different processes according 
to your particular business requirements.

Managing Incoming Inquiries
In this scenario, a customer has moved since last filing a return with the tax agency. The customer 
is expecting a refund, but has not received the refund check because the tax agency has been unable 
to finish processing the refund. The tax agency has sent correspondence to the customer, but it has 
been returned to the agency as undeliverable.

The customer calls the tax agency and is routed to Customer Service. The customer enters personal 
identification information into an Interactive Voice Recognition (IVR) system. At that point, a 
workflow in the application system automatically takes the customer service representative (CSR) to 
the screen where customer details are available. The system provides the CSR with demographic 
information, including the incorrect address and previous attempts to communicate with the 
customer.

The CSR confirms the identity of the caller, and realizes that the address on the customer's record 
is incorrect. The CSR gets the correct information from the customer and updates the record. A 
configured workflow triggers the change of address notification to other back-office application 
systems such as financial systems.

Escalating Cases
In this scenario, a customer has an outstanding collection case with the tax agency. The customer 
has not made any attempt to pay off the liability because the customer disagrees with the amount 
of the penalty established by the tax authority. The customer calls the tax agency for clarification on 
the penalty. The tax agent responds to the question and can access details of the customer's case 
to talk with the customer about the penalty in greater detail. Because the customer does not agree 
with the amount of the liability, the agent escalates the case and assigns it to the next level agent, 
where the case worker performs further analysis and records an assessment for the case.

Managing a Tax Audit Case
In this scenario, a customer has completed a tax return with zero outstanding tax due for the tax 
period, and has filed the tax return. The tax case worker creates an audit case for the tax filing, after 
assessing the tax return, based on the criteria defined by the tax agency and tax laws for the period. 
The tax case worker has access to all of the tax case history records for the customer (including 
customer profile information such as taxpayer identification number, Social Security identification, 
and tax accounts) and can talk intelligently with the customer about the case in consideration for the 
tax period.
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Managing a Tax Appeals Case
In this scenario, a customer receives a collection invoice from the tax agency for an outstanding 
balance. The customer calls the tax agency, where the call is routed to the collection agent 
responsible for the case. After discussing the invoice, the customer informs the case agent that he 
wants to appeal the invoice amount. At this stage, the collections case agent changes the case type 
to Appeals and the case is automatically assigned to the appropriate agent in the appeals division 
based on the application's assignment rules.

Process of Managing Tax Cases
This section details sample tasks typically performed by end users when managing tax cases. Your 
agency may follow a different process according to its business requirements. 

End-User Procedures
To manage tax cases, perform the following procedures:

1 Working with Tax Case Files on page 73

2 Adding Case Attachments and Notes on page 74

3 Managing the Case Calendar and Activities on page 75

4 Tax Case Assessment Tasks on page 76

5 Routing and Assignment of a Tax Case on page 76

6 Associating a Contact or a Partner with a Case on page 77

7 Case Correspondence Management on page 77

8 Tracking Case Status on page 78

9 Closing and Reopening a Case on page 78

Working with Tax Case Files
Cases in Siebel Public Sector can be created either manually or automatically. 

When creating a case manually, a tax case worker navigates to the Cases screen and creates a new 
case record with pertinent details (such as the associated contact). Alternatively, the user can 
navigate to the Contacts screen and create a case record for the contact.

When a case is created, its status automatically defaults to Active. The agent can scan a document 
such as a tax return to create an attachment record in the system. The agent also can associate a 
case record with previous scanned documents that are available in another document management 
system. For example, if the tax agency electronically stores tax returns in a document management 
system such as File Net™ or Documentum™, then documents from these systems can be associated 
with the case records as attachments. 
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Case records can also be automatically created based on events in external systems, with the help 
of a configured workflow. Additionally, case records can be loaded in bulk using Siebel Enterprise 
Integration Management (EIM) or Enterprise Application Integration (EAI). For more details on using 
EIM and EAI, see the Siebel Enterprise Integration Manager Administration Guide and the 
appropriate Siebel Business Application Integration document on Siebel Bookshelf.

Creating Multiple Case Records
A tax case worker may be required to create multiple cases for the customer. For example, a 
corporate customer might have an open case for the tax period because of a pending inquiry into the 
filed tax return, and the tax case auditor has opened another case for a new tax period. To meet this 
type of requirement, the tax case worker can create multiple case records for the customer.

This task is a step in “Process of Managing Tax Cases” on page 73.

To add a tax case file

1 Navigate to the Cases screen > Cases Home view.

2 In the Add form, enter details about the new case.

3 Click Add and Go.

Adding Case Attachments and Notes
The tax agent can capture additional details electronically as the case is developed. Siebel Public 
Sector allows the incorporation of several types of detailed information.

The attachments feature can be used to add electronic documents relevant to the case. For example, 
a customer's tax return or a letter received in the mail can be scanned and stored electronically. The 
attachment can be in any format, such as a word processing document or a spreadsheet containing 
case analysis details.

Users can also record important notes for a case which can be shared with other employees in the 
tax agency or can be marked private, for viewing only by the employee who created the note.

These tasks are a step in “Process of Managing Tax Cases” on page 73.

To create an attachment

1 Navigate to the Cases screen > Case List view.

2 In the Cases list, query for the case name or case number.

3 In the case record, click the link in the Case Name field.

4 From the case form, click the Attachments view tab.

5 In the attachments list, click New File or New URL to associate the document or other media with 
the case record.
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To create case notes

1 Navigate to the Cases screen > Case List view.

2 In the Cases list, query for the case name or case number.

3 In the case record, click the link in the Case Name field.

4 From the case form, click the Notes view tab.

5 In the Notes view, select either Public Notes or Private Notes to control the record's visibility.

6 Create a note record, select the note Type, and enter the information in the Description field.

7 Click Check Spelling to verify spelling in the note text.

Managing the Case Calendar and Activities
The calendar can be used to schedule case activities, meetings, as a meeting invitation tool for 
participants, and to reserve resources required for a meeting. 

To create a new activity template or modify an existing one required by your agency or division, refer 
to Applications Administration Guide. For more information administering and using the calendar, see 
Applications Administration Guide and Fundamentals.

These tasks are a step in “Process of Managing Tax Cases” on page 73

To create a new case activity

1 Navigate to the Cases screen > Case List view.

2 In the Case List, query for the case name or case number.

3 In the case record, click the link in the Case Name field. 

4 From the Case form, click the Activity View tab.

5 In the Activity List view, create a new activity.

6 In the Activity record, select the appropriate value in the Type field, and add a description.

7 In the Activity record, click the link in the Type field.

8 In the activity form, complete additional fields, and select the activity display method in the 
Display In field.

To associate an activity plan with predefined activities to the case

1 Navigate to the Cases screen > Case List view.

2 In the Cases list, query for the case name or case number.

3 In the case record, click the link in the Case Name field.

4 From the Case form, click the Activity Plan view tab.

5 In the Activity Plans list, create a new record.
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6 In the new record, select the predefined template in the Template field.

7 Scroll down to the Activities list to view the predefined activities associated with the activity plan. 

To add participants and resources for a meeting

1 Navigate to the Case List view, and query for the case name or case number.

2 In the case record, click the link in the Case Name field.

3 From the Case form, click the Calendar view tab.

4 In the Calendar view, click on the Date field to create a new record.

5 In the Calendar Detail form, complete the fields.

6 In the Participant Availability calendar, click the appropriate button to add an employee or a 
contact.

7 Click Add Resource to reserve equipment such as a projector or a conference room.

Use the filters to display the calendar availability during working hours, or for 24 hours.

Click Remove Participant to remove a participant from the calendar event.

Tax Case Assessment Tasks
Tax cases may need to be periodically evaluated to help case workers determine the next course of 
action. Siebel Public Sector provides a case assessment tool to help case workers in making these 
decisions, resulting in more uniform decision processes across the tax agency. Users can work from 
predefined assessment templates, which can be triggered automatically with the help of a workflow 
at different stages in the case's lifecycle.

Administrators or managers at the tax agency can define or modify the assessment templates. The 
predefined assessment template has attributes in the form of simple questions with weighted values 
for each question. Each response has an associated score. Completing the assessment provides an 
overall score for the given case that can help the case worker make the appropriate decisions.

To create or modify an assessment template with associated attributes, see Applications 
Administration Guide.

To work with an existing assessment template, see “Assessment of Benefits Using Templates and 
Activities” on page 43.

Routing and Assignment of a Tax Case
A tax case can be routed to the next available agent or to an agent who has previously served the 
client by setting appropriate assignment rules. The case agent can escalate a case to a manager in 
the legal or appeals division who is primarily responsible for coordinating assessment activities. 
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Cases can be assigned manually by adding another user to the Case Team field and selecting that 
user as primary, or by setting up an assignment rule, based on various criteria of the case record. 
For more information on setting up assignment rules and workflows, see Siebel Assignment Manager 
Administration Guide.

Associating a Contact or a Partner with a Case
The case agent can associate one or more contacts with a case record. Partners can be used to track 
tax preparers, law firms, or other third party organizations involved in a particular case.

These tasks are a step in “Process of Managing Tax Cases” on page 73

To add a contact to a tax case

1 Navigate to the Case List view, and query for the case name or case number.

2 In the case record, click the link in the Case Name field.

3 From the Case form, click the Contacts view tab.

4 In the Contact list, click new and select an existing contact. 

Create a new contact by clicking New in the Add Contact dialog box.

To add a partner

1 Navigate to the Case List view, and query for the case name or case number.

2 In the case record, click the link in the Case Name field.

3 From the Case form, click the Partners view tab.

4 In the Partners list, click New and select a predefined partner to associate with the case.

When a partner is associated with a case record, the partner record is automatically designated 
as the primary. You can change the primary partner if more than one partner is associated with 
the case record.

Case Correspondence Management
When correspondence is generated using Siebel Correspondence, an activity record of type 
correspondence is automatically created and associated with the customer record. For example, a 
tax agency employee might use Siebel Correspondence to mail a reminder notice with a tax return 
form to a customer who has not filed a tax return for the tax period.

For more information on using Siebel Correspondence, refer to the correspondence topic in Siebel 
Correspondence, Proposals, and Presentations Guide.
Siebel Public Sector Guide Version 7.8 77



Managing Tax Cases ■ Working with Tax Case Files
Tracking Case Status
Managers in the taxpayer services division, tax processing division, taxpayer audit division or 
enforcement division can track the status of cases with the help of predefined queries.

To create a new query or modify the existing predefined query for your agency or division, refer to 
Applications Administration Guide.

This task is a step in “Process of Managing Tax Cases” on page 73.

To track case status using predefined queries

1 Navigate to the Case List view.

2 From the Queries drop-down list, select a predefined query.

3 For example, choose Active Cases, Appealed Cases, All Closed Cases, and so on.

Closing and Reopening a Case 
After assessing the case records, the case worker can close a case, or reopen closed cases.

This task is a step in “Process of Managing Tax Cases” on page 73.

To close or reopen a case

1 Navigate to the Cases Home screen and query for the case.

2 In the Case record, change the value in the Status field to Closed or Active.
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This chapter describes the procedures for managing Immigration Contacts. It includes the following 
topics:

■ About the Immigration Contacts Screen on page 80

■ Scenario for Managing Immigration Contacts and Identities on page 81

■ Process of Managing Immigration Contacts on page 82

■ Adding a Contact Identity Record on page 82

■ Documenting Immigration Contact Credentials on page 85

■ Documenting Identity History on page 86

■ Merging Immigration Contacts on page 87

■ Managing Visitor Stays on page 87

■ Administering Immigration Contacts on page 89
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About the Immigration Contacts Screen
The Immigration Contacts screen is based on the S_CONTACT table and Contact business component 
and is intended as a replacement for the Contacts screen for those customers managing immigration 
processes. If both the Contacts screen and the Immigration Contacts screen are used simultaneously 
in a deployment, it results in incorrect data being created in the system.

Administrators should deactivate the Contacts screen, and then set the Immigration Contacts screen 
to display as the default. For more information, see Using Siebel Tools. After this task is done, 
administrators may want to revise the screen tab label from Immigration Contacts to Contacts.

In addition to the standard set of views provided within the Immigration Contacts screen, 
administrators can easily copy views from the Contacts screen to augment the Immigration Contacts 
module. After identifying the views in the Contact screen, the administrator can copy each view and 
make the following changes:

■ Screen - PUB Immigration Contacts Screen

■ View Name - <Create New View Name>

■ Business Object - PUB Immigration Contact

■ Applet[0] - PUB Immigration Contact Form Applet

The ability to track identities, credentials, and photographs for a contact may be relevant to other 
public sector organizations. The screen tab can easily be relabeled as Contacts or Public Sector 
Contacts instead of the preconfigured label, Immigration Contacts.
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Scenario for Managing Immigration 
Contacts and Identities
This scenario provides an example of a process performed by immigration and citizenship agency 
users. Your agency may follow a different process according to its business requirements.

Arrival Management
A traveler arrives at an airport from another country on an international flight. After arrival, the 
traveler passes through immigration, where an immigration officer reviews the traveler’s 
documentation. The immigration officer searches for the traveler in the system, using a variety of 
different identification methods including entering in her passport number, swiping the passport's 
magnetic strip in a reader, or using a biometric device to compare the traveler’s fingerprint or other 
biometric to a database of biometric records.

The immigration officer verifies that the traveler has valid credentials (passport or visa) for 
admission to the country, and that the credentials match the traveler’s credentials in the system. 

The immigration officer enters confirmation of admittance to the country in the system, and collects 
additional information from the traveler, such as where the traveler will be staying during the visit. 
This information is collected on a paper form, which is entered into the system at a later time.

For travelers whose credentials are not in order, or who are flagged for security reasons, the 
immigration officer sends the travelers to secondary screening area for additional questioning. 

Stay Management 
When the traveler leaves the country, the departure is recorded by an immigration officer. The 
traveler’s record is located in the system, and it is updated to reflect the departure. 

The system continually monitors for travelers who have arrived in the country but have not departed 
by the date on which their credentials expire. When travelers who have overstayed are located, the 
system alerts the appropriate enforcement officers and provides information to assist in tracking 
down the travelers.

Case Creation
A case processor is assigned a number of paper applications that have been received in the case 
processing center.

For each application, the case processor checks to see whether the applicant is already in the system, 
and if the applicant is not in the system, the case processor creates a new case record and associates 
the applicant with the case. The case processor verifies that the contact details are the same as in 
the paper application. If the contact is not in the system, the case processor creates a new record 
for the applicant, capturing the details provided in the application.
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Citizenship Identity Update and Matching
A client completes a form to alert the citizenship agency that her marital status and last name has 
changed to that of her new husband. When the form is received by the agency, a citizenship clerk 
locates the client’s record and updates her last name and marital status as a new identity. The clerk 
also maintains a record of Diane's prior marital status and last name in the system.

While researching a citizenship case for another client, the clerk finds a previous contact record 
created for the client when he applied for citizenship 20 years earlier. Although the two records have 
different citizenships, the clerk determines that the records are likely to be for the same person, 
because both have the same name, birth date, and other characteristics. The clerk selects the older 
record and links it with the new record for the client. 

Process of Managing Immigration 
Contacts
This section details sample tasks typically performed by administrators and end users when 
managing immigration and citizenship contacts and applications. In this process, the administrative 
tasks, which are primarily maintenance of database records, follow the tasks performed by end 
users. Your organization may follow a different process according to its business requirements. 

End-User Procedures
The following list shows tasks end users typically perform to manage immigration and citizenship 
contacts.

■ Adding a Contact Identity Record on page 82

■ Documenting Immigration Contact Credentials on page 85

■ Documenting Identity History on page 86

■ Merging Immigration Contacts on page 87

■ Managing Visitor Stays on page 87

Administrator Procedures
The following task is typically performed by an administrator to manage Immigration Contacts and 
Identities in the database.

■ Administering Immigration Contacts on page 89

Adding a Contact Identity Record
Before adding a new immigration contact, use the Immigration Contacts Home page to query for the 
contact. From the home page you can search for the contact by last name, first name, gender, birth 
date and citizenship.
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A new contact can only be created from the Identity list view. The Identities list view shows all 
identities regardless of contact. An identity record is created and saved, and a contact ID is 
automatically generated from the Identity. Users can then drill into the Contact ID field and add 
additional details such as addresses, cases, credentials, photographs, and so on.

When a new identity is created for a contact, its default status is Active, and the identity defaults to 
the primary identity for the contact. A previous active identity is changed to inactive, and the Expired 
Date for the identity is populated with the current date. Users can override the defaults by updating 
the status, or selecting a different primary identity.

On the Immigration Contacts More Info view, the contact's primary identity appears in the identity 
form. Users can see other identities from the same view. The colored icon in the More Info view 
header indicates the status of the displayed identity record. For active identities, the icon is green; 
for inactive identities, the icon is red.

A list of all identities for a particular contact is available on the Immigration Contact Identity History 
view.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To add an immigration contact

1 Navigate to the Immigration Contacts screen > Identities view.

2 Expand the identity form to show all fields.

3 In the Identities list, add an identity, and complete the fields.

NOTE: The Secondary Citizenship field is only enabled if the Multiple Citizenship check box flag 
is set.

The following table describes some of the fields.

Fields Comments

Contact ID Automatically populated with a unique value.

Contact Type For Immigration and Citizenship, typical Type values might 
be Visitor or Alien.

Days Overdue The value is populated by the workflow, PUB Immigration 
Overdue Days.

Watchlist Indicator The Watchlist Indicator check box field is available for 
customers who want to integrate the Siebel application with 
external watchlists.

Photograph Available The Photograph Available check box is automatically 
selected if a file has been added to the Immigration Contact 
Photographs view.
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4 Save the Identity.

After the Identity record is saved, the fields become read-only, except for the Status field and 
the Primary flag. If the user needs to change the information in an identity record after it is 
saved, the best practices method is to create a copy of the existing Identity record and update 
the necessary fields before saving it. If necessary, change the status of the old Identity record 
to To be deleted.

Adding Immigration Contact Details
A client's application for citizenship, immigration or visitor status includes a substantial amount of 
information about the applicant including addresses, credentials, associated cases, and so on.

You can add details to the Immigration Contact record, using the associated view such as Identity 
History, Credentials and Stays.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To add Immigration Contact Details

1 Navigate to the Immigration Contacts screen > Immigration Contacts view, and query for the 
contact.

2 Drill down on the Contact ID link, and from the details view, click appropriate subview tabs to 
add information.

3 Click the view tab, add a record and complete the fields.

The following table describes the views.

View Description

More Info This view includes basic contact details in the form at the top and 
information about the contact's primary identity and credentials in the 
bottom form. If there are multiple photos for a contact, users can scroll 
through the photographs by clicking the forward and back icons above the 
photograph.

Activities Use this view to list activities associated with the contact.

Addresses Use this view to list all relevant addresses for the contact.

Attachments Use this view to attach document files associated with the contact.

Cases Use this view to assign a new case record to the contact, or associate the 
contact with an existing case.

Credentials Use this view to list credentials such as passports and visas issued to the 
contact. For more information, see “Documenting Immigration Contact 
Credentials” on page 85.

Identity History Use this view to list of all identities, past and present, associated with the 
contact. For more information, see “Documenting Identity History” on 
page 86.
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Documenting Immigration Contact 
Credentials
When a traveler enters the country, the immigration officer must verify the traveler’s passport and 
visa credentials. Each credential record includes information such as the category, identification 
number, status (active, expired or to be deleted), the issuing country, date issued and expiration 
date. Active credentials from the Contact Credentials view are listed in the Contact More Info view.

Credentials can only be created from the Immigration Contact Credential view, which ensures that 
credential records have a corresponding contact. The Credentials List view shows all credentials 
regardless of contact.

After a credential record is saved, all fields become read-only, except for the status field. If the status 
field is set to Expired, the entire record becomes read-only. Saved credential records cannot be 
deleted by an end user. Only administrators can delete credential records using the Credentials 
Administration view. For more information, see “Administering Immigration Contacts” on page 89.

The Public Sector application includes a preconfigured workflow that finds all active credentials with 
an expiration date equal to the previous day's date, and sets the status for these credentials to 
Expired.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To verify or enter credential information

1 From the Immigration Contacts Home Page, search for the contact.

2 From the Identities list, drill down on the Contact ID link.

3 From the Immigration Contact form, click the Credentials view tab.

Notes Use this view to add notes about the contact. Notes can be designated as 
being a specific type.

Photographs Use this view add photographs to a contact record and review photos. The 
photograph flagged as a the primary appears in the More Info view for 
the contact record.

Stays Use this view to list all stays by the contact, including information on the 
Arrival Date, the Departure date and the visa or passport number. Each 
stay record is given a unique identifier. For more information, see 
“Managing Visitor Stays” on page 87.

View Description
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4 In the Credentials list, add a record and complete the fields.

The following table describes the fields.

Documenting Identity History
As names and other aspects of identities change, the user can add new records to the contact 
Identity History view to document the changes. When a new identity record is created for a contact, 
it defaults to the primary identity, and its status is Active by default.

After the Identity History record is saved, field values other than Status and Primary cannot be 
changed. Incorrect records can be marked (status) for later deletion by the administrator. Each 
identity record is given a unique identifier. The Identity ID field provides a link that the user can use 
to navigate to the Identities list view.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To add an identity record to Identity History

1 From the Immigration Contacts Home Page, search for the contact.

2 From the Identities list, drill down on the Contact ID link.

3 From the Immigration Contact form, click the Identity History view tab.

4 Select an Identity History record, and from the menu choose Copy Record.

5 Make changes in the copied record, and save the changes.

If an active and primary identity record already exists, the copied record becomes the primary 
record. The old primary identity’s status changes to Inactive.

Field Comments

Category The credentials category can either be Visa or Passport.

Type Based on the selected category. For example, if the category is Visa, then 
the type might be tourist, business, student or employment. If the type 
is Passport, the type might be regular, diplomatic or official.

Status Active, Expired or To Be Deleted (by an administrator).

Number This text field allows entry of the identifier associated with the 
credentials. 

Issuing Country The country that issued the visa or passport. 

Date Issued Date Issued defaults to the current date.

Place of Issue The Place of Issue for the credential defaults to the organization of the 
user who creates the credential record.

Expiration Date The date that the credentials expire.
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Merging Immigration Contacts
You can merge records from the Immigration Contacts screen > Immigration Contacts View. When 
two contacts records are merged, the identity records from both contacts are maintained in the 
Contact Identity History for the merged contact. The primary identity for the primary contact in the 
merge becomes the primary identity for the merged contact record. All identity records maintain 
their existing status values.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To merge immigration contacts

1 Navigate to the Immigration Contact Screen > Immigration Contacts list view.

2 Select the immigration contact records to be merged.

The second record selected becomes the primary contact record. The first record is merged into 
the primary record.

3 From the application-level menu, choose Edit > Merge Records.

4 From the dialog box confirming the merge, click OK.

The merged contacts have a new Contact ID.

Managing Visitor Stays
Stay records can only be created from the Stays view associated with the immigration contact. The 
Stays list shows all Stay record regardless of contact, and is primarily used by administrators.

After a stay record is saved, the arrival date, port of entry, and passport number fields become read-
only, and the stay record cannot be deleted by an end user. Only administrators can delete stay 
records from the Stays Administration view. For more information, see Administering Immigration 
Contacts on page 89.

Stay Workflows
A preconfigured workflow is provided that automatically searches all stay records (except those with 
the invalid departure flag selected) to locate visitors who have overstayed the time permitted by their 
visa. The workflow, which runs once a day, looks for the following criteria:

■ The stay has no value for departure date

■ The stay is associated with a visa that has an expiration date later than the current date

For each stay record matching these criteria, the Departure Overdue field for the contact associated 
with the stay is updated to reflect the number of days that the contact is overdue.

Another preconfigured workflow searches all stays (except those with the invalid departure flag 
checked) to locate visitors without visas who are staying beyond the maximum-allowed length of 
stay. This workflow, which also runs once a day, looks for records that have the following criteria:

■ The stay has no value for the departure date
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■ The stay has an arrival date more than 60 days prior to the current date

■ The stay has no value in the Visa field

If the stay records match the criteria, the Departure Overdue field for the immigration contact 
associated with the stay record is updated to reflect the number of days that the contact is overdue. 

The number of days in this workflow (for example, 60) can be changed by an administrator.

This task is a step in “Process of Managing Immigration Contacts” on page 82.

To create a Stay record

1 Navigate to the Immigration Contact Screen > Immigration Contacts list view.

2 In the Immigration Contacts list, query for the contact, and drill down on the Contact ID link.

3 From the Immigration Contact form, click the Stays view tab.

4 In the Stays list, create a record and complete the fields.

The following table describes some of the fields.

Field Comments

Stay ID The unique identifier for the stay is automatically generated by 
the system.

Arrival Date The arrival date field defaults to the current date and time, but 
can be edited by the user.

Port of Entry The port of entry value defaults to the organization of the user 
creating the Stay record.

Passport Number Use this field to associate an existing passport number with the 
stay. Only passports with a status of Active may be selected.

Visa Number Use this field to associate an existing visa number with the stay. 
Only visas with an status of Active may be selected.

Visa Type Automatically populated based on the selected visa.

Departure Date The scheduled date of departure for the stay.

Port of Departure Use this field to select a port of departure for the contact.

Days Overdue Automatically updated with the number of days that the 
contact’s stay is overdue.

Invalid Departure If a new stay record is created for a contact that has a prior stay 
record with no departure date, the invalid departure check box 
flag is selected for the prior stay record.

After the invalid departure flag is selected, the stay record 
becomes read-only. Any value in the days overdue field for that 
stay is cleared.
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Administering Immigration Contacts
Immigration Contacts are added as Identities. To maintain the integrity of the contact and identities 
data, only an administrator may remove a contact or identity record from the database.

Identities have a Status of Active, Inactive or To be deleted. There can only be one designated 
Primary record. However, more than one identity record can have a status of Active.

For a typical user, after an identity record is added and saved no other modifications to the record is 
permitted, except in the status field. For example, if Divorced is selected in the identity record’s 
Marital Status field, and the record is saved, the user cannot then change the Marital Status value 
to Separated. 

After an identity’s status is changed to To be deleted, and saved, no additional status changes are 
permitted. For example, the user cannot change the status from To be deleted to Active or Inactive.

However, the user with Identities Administration, or Immigration Contacts Administration privileges 
can make changes to contact and identity record field values, and manually delete contacts as 
needed.

These tasks are a step in “Process of Managing Immigration Contacts” on page 82.

To administer a contact identity record

1 Navigate to the Immigration Contacts Home screen, and query for the contact.

2 Perform one of the following steps:

a From the Identities view, select Identities Administration from the visibility filter, and from the 
Identities Administration list, select the identity record, and then modify the record or click 
Delete.

b From the Immigration Contacts view, select Immigration Contacts Administration from the 
visibility filter, select the contact in the list, and then modify the record or click Delete.

To administer a credential record

1 Navigate to the Immigration Contacts screen > Credentials view.

2 From the Credentials list, choose Credentials Administration from the visibility filters.

3 From the Credentials Administration list select the credential record, and then modify the record 
or click Delete.

Departure Vessel Text field for entry of additional information about the departure 
vessel, if appropriate to the stay.

Arrival Vessel Number Text field for entry of additional information about the arrival 
vessel, if appropriate to the stay.

Field Comments
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To administer Stay records

1 Navigate to the Immigration Contacts screen > Stays view.

2 From the Stays list, choose Stays Administration from the visibility filter.

3 Query for the Stay record, and then perform one of the following tasks:

a Modify the values in the Stay record.

b From the menu, choose Delete Record to remove the Stay record.
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A Public Sector Responsibilities 
and Views
This appendix lists the preconfigured responsibilities that are specific to Siebel Public Sector. It 
includes the following topics:

■ Public Sector Responsibilities on page 92

■ Investigative Case Management Responsibility on page 92

■ Incident Management Responsibility on page 94

■ Threat and Response Management Responsibility on page 94

■ Benefits Case Management Responsibility on page 95
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Public Sector Responsibilities
A number of responsibilities are defined within the preconfigured Siebel application to support Siebel 
Public sector users. The following sections list the responsibilities and the views employees with each 
responsibility can access.

These responsibilities can be assigned to Siebel users using the same procedure through which 
responsibilities for other Siebel Business Applications are assigned, as described in Applications 
Administration Guide. 

Investigative Case Management 
Responsibility
The following views are visible to the employee with this responsibility:

■ PUB GOV Home Page

■ HLS Account Case

■ HLS All Case List

■ HLS All Groups List

■ HLS All Suspect List

■ HLS Case Account

■ HLS Case Activities

■ HLS Case Attachment

■ HLS Case Auto Vehicles

■ HLS Case Detail

■ HLS Case Disease

■ HLS Case Groups

■ HLS Case List

■ HLS Case Note

■ HLS Case Partner

■ HLS Case Preview

■ HLS Case Project

■ HLS Case Related Case

■ HLS Case Sales Assessment

■ HLS Case Service Request

■ HLS Case Suspect

■ HLS Group Preview
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Responsibility
■ HLS Groups Activities

■ HLS Groups Address

■ HLS Groups Attachment

■ HLS Groups Case 

■ HLS Groups Detail 

■ HLS Groups List 

■ HLS Groups Note 

■ HLS Groups Suspect 

■ HLS Suspect Activities 

■ HLS Suspect Address 

■ HLS Suspect Associated Suspect 

■ HLS Suspect Attachment 

■ HLS Suspect Case 

■ HLS Suspect Details 

■ HLS Suspect Group 

■ HLS Suspect List 

■ HLS Suspect Note 

■ HLS Suspect Preview 

■ PUB Case Audit Trail 

■ PUB GOV Case Activity Plans 

■ PUB GOV Case Monthly Calendar 

■ PUB GOV Channel Partner Cases 

■ PUB GOV Contact Cases 

■ PUB HLS Case Contact 

■ PUB HLS Case Incident 

■ PUB HLS Groups Incident 

■ PUB HLS My Team Group List 

■ PUB HLS My Team Suspect List 

■ PUB HLS Suspect Incident 

■ PUB My Team Case List 

■ Relationship Hierarchy (Groups)
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Incident Management Responsibility
The following views are visible to the employee with this responsibility:

■ PUB GOV Home Page

■ PUB HLS All Incident List

■ PUB HLS Case Incident

■ PUB HLS Contact Incident

■ PUB HLS Exception Handling

■ PUB HLS Groups Incident

■ PUB HLS Incident Activities

■ PUB HLS Incident Attachment

■ PUB HLS Incident Detail

■ PUB HLS Incident Group

■ PUB HLS Incident List

■ PUB HLS Incident Note

■ PUB HLS Incident Preview

■ PUB HLS Incident Suspect

■ PUB HLS My Team Incident List

■ PUB HLS Suspect Incident

■ All Service Requests Simple

Threat and Response Management 
Responsibility
The following views are visible to the employee with this responsibility:

■ PUB GOV Home Page

■ Disease Attachment

■ Disease Cases

■ Disease List

■ Disease Medication

■ Disease Service Request

■ Disease Training

■ Diseases Detail

■ HLS All Medication List
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■ HLS Case Disease

■ HLS Disease FAQ

■ HLS Disease Preview

■ HLS Medication Diseases

■ HLS Medication Drug Interactions

■ HLS Medication Inventory

■ HLS Medication List

■ HLS Medication Substitutes

■ My Disease List

Benefits Case Management 
Responsibility
The following views are visible to the employee with this responsibility:

■ HLS Account Case

■ HLS All Case List

■ HLS Case Account

■ HLS Case Activities

■ HLS Case Attachment

■ HLS Case Detail

■ HLS Case INS Claims

■ HLS Case List

■ HLS Case Note

■ HLS Case Partner

■ HLS Case Preview

■ HLS Case Project

■ HLS Case Quote

■ HLS Case Related Case

■ HLS Case Sales Assessment

■ HLS Case Service Request

■ PUB GOV Home Page

■ PUB GOV Channel Partner Cases

■ PUB GOV Contact Cases
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■ PUB GOV Household Cases

■ PUB HLS Case Contact

■ PUB My Team Case List
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